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Preface

Purpose

This User Guide explains how to manage Talend Open Studio functions in a normal operational 
context. 

Information presented in this document applies to Talend Open Studio releases beginning with 
3.2.x.

Audience

This guide is for users and administrators of Talend Open Studio.

The layout of GUI screens provided in this document may vary slightly from your 
actual GUI.

Typographical conventions

This guide uses the following typographical conventions:

• text in bold: window and dialog box buttons and fields, keyboard keys, menus, and menu 
and options,

• text in [bold]: window, wizard, and dialog box titles,

• text in courier: system parameters typed in by the user,

• text in italics: file, schema, column, row, and variable names,

• The  icon indicates an item that provides additional information about an important 
point. It is also used to add comments related to a table or a figure,

• The  icon indicates a message that gives information about the execution requirements 
or recommendation type. It is also used to refer to situations or information the end-user need 
to be aware of or pay special attention to.

History of changes

The below table lists the changes made in the 3.x release of the Talend Open Studio User Guide.

Version Date History of Change

v3.0_a 10/08/2008 Updates in Talend Open Studio User Guide include: 
- New functionalities in Talend Open Studio

v3.0_b 10/08/2008 Updates in Talend Open Studio User Guide include: 
-Updated access information for Talend Open Studio 
-New functionality: SQL templates 
-Having “Data integration and Talend Open Studio” as a separate 
chapter 
-Having “Theory into practise: Job example” as an Appendix
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Feedback and Support

Your feedback is valuable. Do not hesitate to give your input, make suggestions or requests regarding 
this documentation or product and find support from the Talend team, on Talend’s Forum website at:

http://talendforge.org/forum 

v3.0_c 17/12/2008 No updates in Talend Open Studio User Guide.

v3.1_a 30/04/2009 Updates in Talend Open Studio User Guide include: 
-Handling lookups 
-Sharing database connection 
-Replacing Ecosystem with Talend exchange 
-Project settings re-organization 
-Preferences re-organization 

v3.1_b 20/05/2009 Updates in Talend Open Studio User Guide include: 
-Talend exchange re-organization 
-Modelling a Business Model re-organization 
-Displaying Traces expansion 
-Exporting jobs as JBoss ESB adding 
-Harmonization of the titles 

v3.1_c 18/06/2009 Updates in Talend Open Studio User Guide include: 
-More details to JBoss ESB Export Jobscript 
-Some modifications in Salesforce wizard 
-relocating the information related to “Automatic updates of 
documentation of Job/Joblet” in the doc to match the Studio 
preferences 
-Shortcut and aliases table 

v3.2_a 21/10/2009 Updates in Talend Open Studio User Guide include: 
-New section: Important concepts in the Studio  
-Reorganizing information between the Getting started and Managing 
Jobs chapters 
- Ability to connect to different workspaces 

Version Date History of Change
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CHAPTER 1 

Data integration and Talend Open Studio
There is nothing new about the fact that organizations’ information systems tend to grow in 
complexity. The reasons for this include the “layer stackup trend” (a new solution is deployed 
although old systems are still maintained) and the fact that information systems need to be more and 
more connected to those of vendors, partners and customers.

A third reason is the multiplication of data storage formats (XML files, positional flat files, 
delimited flat files, multi-valued files and so on), protocols (FTP, HTTP, SOAP, SCP and so on) and 
database technologies.

A question arises from these statements: How to manage a proper integration of this data scattered 
throughout the company’s information systems? Various functions lay behind the data integration 
principle: business intelligence or analytics integration (data warehousing) and operational 
integration (data capture and migration, database synchronization, inter-application data exchange 
and so on).

Both ETL for analytics and ETL for operational integration needs are addressed by Talend Open 
Studio.



Data integration and Talend Open Studio
Data analytics
1.1 Data analytics

While mostly invisible to users of the BI platform, ETL processes retrieve the data from all operational 
systems and pre-process it for the analysis and reporting tools.

Talend Open Studio offers nearly comprehensive connectivity to:

• Packaged applications (ERP, CRM, etc.), databases, mainframes, files, Web Services, and so on 
to address the growing disparity of sources.

• Data warehouses, data marts, OLAP applications - for analysis, reporting, dashboarding, 
scorecarding, and so on. 

• Built-in advanced components for ETL, including string manipulations, Slowly Changing 
Dimensions, automatic lookup handling, bulk loads support, and so on.

Most connectors addressing each of the above needs are detailed in the Talend Open Studio 
Components Reference Guide. For information about their orchestration in Talend Open Studio, 
see Designing a Job on page 65. For high-level business-oriented modeling, see Designing a Business 
Model on page 53.

1.2 Operational integration

Operational data integration is often addressed by implementing custom programs or routines, 
completed on-demand for a specific need. 

Data migration/loading and data synchronization/replication are the most common applications of 
operational data integration, and often require:

• Complex mappings and transformations with aggregations, calculations, and so on due to 
variation in data structure,
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Data integration and Talend Open Studio
Execution monitoring
• Conflicts of data to be managed and resolved taking into account record update precedence or 
“record owner”,

• Data synchronization in nearly real time as systems involve low latency.

Most connectors addressing each of the above needs are detailed in the Talend Open Studio 
Components Reference Guide. For information about their orchestration in Talend Open Studio, 
see Designing a Job on page 65. For high-level business-oriented modeling, see Designing a Business 
Model on page 53.

1.3 Execution monitoring

One of the greatest challenges faced by developers of integration processes and IT Operations staff in 
charge of controlling their execution is to be able to control and monitor the execution of these critical 
processes. Indeed, failure handling and error notification can - and should - be included in data 
integration processes.

Furthermore, beyond on-error notification, it is often critical to monitor the overall health of the 
integration processes and to watch for any degradation in their performance.

The Activity Monitoring Console monitors job events (successes, failures, warnings, etc.), execution 
times and data volumes through a single consoleavailable as a standalone environment.

For more information regarding Activity Monitoring Console operation, check out the Activity 
Monitoring Console User Guide.
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Execution monitoring
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CHAPTER 2 

Getting started with Talend Open Studio
This chapter introduces Talend Open Studio. It provides detail description of the Graphical User 
Interface (GUI) and basic configuring information necessary to start with Talend Open Studio.

This chapter guides you through the basics for creating local projects and those for setting 
preferences and personalizing workspace in Talend Open Studio.



Getting started with Talend Open Studio
Important concepts in Talend Open Studio
2.1 Important concepts in Talend Open Studio

When working with Talend Open Studio, you will always come across words like, repository, project, 
workspace, job, component and item.

Understanding the implementation of each of these words is very important to grasp the functional 
mechanism of Talend Open Studio.

What is a repository: A repository is the storage location Talend Open Studio uses to gather data 
related to all technical items that you use either to describe business models or to design Jobs.  
Talend Open Studio can connect to as many local repositories as needed. For more information, see 
Accessing one or multiple Repositories on page 8.

What is a project: Projects are structured collections of technical items and their associated metadata. 
That is you organize all the Jobs and business models you design in terms of Projects. 
You can create as many projects as you need in a repository. For more information about projects, see 
Working with projects on page 12.

What is a workspace: A workspace is the directory where you store all your project folders. You need 
to have one workspace directory per connection (repository connection). Talend Open Studio enables 
you to connect to different workspace directories, if you do not want to use the by-default one. 
For more information about workspace, see Working with different workspace directories on page 10.

What is a job: A job is a graphical design, of one or more components connected together, that allows 
you to put in place up and running dataflow management processes. It translates business needs into 
code, routines and programs. Jobs address all different sources and targets that you need for data 
integration processes and all related aspects. 
For detailed information about how to design data integration processes in Talend Open Studio, see 
Designing a Job on page 65.

What is a component: A component is a preconfigured connector used to perform a specific data 
integration operation, no matter what data sources you are integrating: databases, applications, flat files, 
Web services, etc. A component can minimize the amount of hand-coding required to work on data from 
multiple, heterogeneous sources. 
Components are grouped in families according to their usage and displayed in the Palette of Talend 
Open Studio main window. 
For detailed information about components types and what they can be used for, see Talend Open 
Studio Reference Guide.

What is an item: An item is the fundamental technical unit in a project. Items are grouped, according 
to their types, as: Job Design, Business model, Context, Code, Metadata, etc. One item can include other 
items. For example, the business models and the Jobs you design are items, metadata and routines you 
use inside your Jobs are items as well.

2.2 Launching Talend Open Studio

Talend Open Studio requires the connection to at least one repository and the creation of at least one 
project to be launched for the first time.

To launch the Studio for the first time, do the following:

First step: 
After you unzip Talend Open Studio zipped file and when you try to launch the Studio, you will be 
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Getting started with Talend Open Studio
Launching Talend Open Studio
presented with a brief setup wizard. Follow the installation instructions provided to successfully launch 
the current instance. 
Read and accept the terms of the license agreement to continue.

Second step: 
On Talend Open Studio login window, create a connection to a local repository. This repository will 
store all the derived data and metadata associated with the projects and items in the project. It will also 
store different versions of project items.  
For more information about the connection to the local repository, see How to connect to a local 
repository on page 8.

Third step: 
Create or import a project and then open this project to launch Talend Open Studio.  
For more information about the different actions you can do on projects, see Working with projects on 
page 12.

A [Registration] window prompts you for your email address and location. This information is optional. 

If you enter your email, you will be informed about all future enhancements of Talend Open Studio.

• If needed, select the enable HTTP Proxy parameters check box to enable the HTTP Proxy 
parameters and fill in the fields that follow with your proxy details. Make sure that you fill in the 
email address field if you provide proxy details.

 You can fill in or edit the registration information at any time, through Window > 
Preferences > Talend > Install/Update.

 Be ensured that any personal information you may provide to Talend will never be 
transmitted to third parties nor used for another purpose than to inform you about Talend 
and Talend’s products.
Creative Commons License Talend Open Studio 7
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Getting started with Talend Open Studio
Launching Talend Open Studio
• Click Cancel to close the [Registration] dialog box.

Talend Open Studio main window displays on a Welcome view. 

• Click Start now to close the view and open Talend Open Studio multi-panel main window.

For more information about the Studio main window, see Describing the GUI on page 18.

2.2.1 Accessing one or multiple Repositories

On Talend Open Studio login window, you can connect to one or multiple local repository where 
you store the data of all projects including Jobs and business models, metadata, routines, etc. 

How to connect to a local repository

On Talend Open Studio login window, you can connect to the local repository doing as follows:

• Click the three-dot button to open another view of the login window and set the 
connection information.

if you have already set your user name and connection details, you can directly 
select the relevant entry on the Repository list of the Connection area.
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Getting started with Talend Open Studio
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• If needed, type in a name and a description for your connection in the relevant fields.

• In the User E-mail field, type in the email address that will be used as user login. This 
field is compulsory to be able to use Talend Open Studio.  
Be aware that the email entered is never used for other purpose than logging in.

• If needed, click the plus (+) button in the lower left corner and set the connection 
information to add as many connections as needed.

• The Workspace field shows by default the path to the current workspace directory 
holding all folders of the created project. You can still modify this path or indicate the 
access path to another workspace through clicking the three-dot button next to the field.

If you modify the path to the workspace directory, a message on the login window 
will prompt you to restart the Studio. Click the Restart button on the login 
window to restart the Studio and access the project(s) of the indicated workspace. 

For more information about how to connect to a different worspace, see Working with 
different workspace directories on page 10

• Click OK to validate your changes and close the new view.

The login window displays prompting you to select a project-related option from the Select list. 

Usually, when you connect to the Studio for the first time, you need to create a new  project. For 
more information about how to create a project, see How to create a project on page 12.

For information about all other possible operations on projects, see Managing jobs on page 181.

2.2.2 Setting up a project in the Repository

In order to be able to open the main window of Talend Open Studio, you need first to set up a 
project in the repository you connected to earlier.

You can set up a project in the Repository by:

• creating a new project. For more information, see How to create a project on page 12.

• importing one or more local projects you already created with other instances of Talend 
Open Studio. For more information, see How to import a project on page 14.
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• importing the Demo project. For more information, see How to import the Demo project on 
page 14. 

2.3 Working with different workspace directories

Talend Open Studio makes it possible to create many workspace directories and connect to a workspace 
different from the current one, if needed. 

This flexibility enables you to store these directories wherever you want and give the same project name 
to two or more different projects as long as you store the projects in different directories. 

2.3.1 Creating a new workspace directory

Talend Open Studio is delivered with a by-default workspace directory. However, you can create 
as many new directories as you want and store your project folders in them according to your 
preferences.

To create a new workspace directory:

• On Talend Open Studio login window, click the three-dot button next to the Repository 
field to open another view of the window.

• In the WorkSpace field, set the path to the new workspace directory you want to create and 
then click OK to close the view. 
On the login window, a message displays prompting you to restart the Studio.

• Click restart to restart the Studio.

• On the reinitiated login window, set up a project for this new workspace directory. 
For more information, see Setting up a project in the Repository on page 9.
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• Select the project from the Or list and click Open to open Talend Open Studio main 
window.

All business models or Jobs you design in the current instance of the Studio will be stored in the new 
workspace directory you created. For information on how to connect to a different workspace, see 
the below section.

2.3.2 Connecting to a different workspace directory

On the login window of Talend Open Studio, you can select the workspace directory you want to 
store your project folders in according to your preferences.

To change the workspace directory:

• On Talend Open Studio login window, click the three-dot button next to the Repository 
field to open another view of the window.

• Click the three-dot button next to the WorkSpace field to open a dialog box where you can 
browse to the workspace directory you want to connect to. 

• Select the workspace directory in the dialog box of your operating system and click OK. 
The dialog box closes and the path to the selected workspace directory is set in the 
Workspace field.

• Click OK to close the view. 
On the login window, a message displays prompting you to restart the Studio.

• Click restart to restart the Studio.

• On the reinitiated login window and from the Or list, select a project and click Open to open 
Talend Open Studio main window. 
All business models or Jobs you design in the current instance of the Studio will be stored 
in the selected workspace directory.
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2.4 Working with projects

In Talend Open Studio, the highest physical structure for storing all different types of data integration 
Jobs and business models, metadata, routines, etc. is “project”.

From the login window of Talend Open Studio, you can:

• import the Demo project to discover the features of Talend Open Studio based on samples of 
different ready-to-use Jobs. When you import the Demo project, it is automatically installed in 
the workspace directory of the current instance of the Studio. 
For more information, see How to import the Demo project on page 14.

• create a local project. When connecting to Talend Open Studio for the first time, there are no 
default projects listed. You need to create a local project and open it in the Studio to store all the 
Jobs and business models you create in it. When creating a new project, a tree folder is 
automatically created in the workspace directory on your repository server. This will correspond 
to the Repository tree view displaying on Talend Open Studio main window. 
For more information, see How to create a project on page 12.

• If you already created projects with previous releases of Talend Open Studio, you can import 
them into your current Talend Open Studio workspace directory using the Import existing 
local project(s) option. 
 For more information, see How to import a project on page 14.

• open a project you created or imported in the Studio. For more information, see How to open a 
project on page 16.

• delete local projects that you already created or imported and that you do not need any longer. 
For more information, see How to delete a project on page 16.

Once you launch Talend Open Studio, you can export the resources of one or more of the created 
projects in the current instance of the Studio. For more information, see How to export a project on page 
17.

2.4.1 How to create a project

When you connect to the local repository of the current Studio for the first time, there are no default 
projects listed. You need to create a project that will hold all data integration Jobs and business 
models you design in the current instance of the Studio. 

To create a  project:

• Launch Talend Open Studio and connect to a local repository.

• From the Select list in the Project area of the Studio login window, select Create a new local 
project and click Go. 
The [New project] dialog box displays.
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• In the Project name field, enter a name for the new project. This field is mandatory. 
A message shows at the top of the wizard, according to the location of your pointer, to inform 
you about the nature of data to be filled in, such as forbidden characters

The read-only “technical name” is used by the application as file name of the actual 
project file. This name usually corresponds to the project name, upper-cased and 
concatenated with underscores if needed.

• Select the Generation language between Perl and Java. Later when designing Jobs and 
working with the different Talend data integration components, you have to use Perl code 
in Perl projects and Java code in Java projects.

• Click Finish. The name of the newly created project displays in the Or list in Talend Open 
Studio login window.

To open the newly created project in Talend Open Studio, select it from the Or list and then click 
Open. A generation engine initialization window displays. Wait till the initialization is complete.

Later, if you want to switch between projects, on the Studio menu bar, use the combination File > 
Switch Projects.

We strongly discourage having too many heterogeneous projects in both languages an switching from one 
Perl project to a java project too often. Nevertheless, if you still want to work in both languages, we advise 
you to keep them in separate locations or even to launch two distinct instances of Talend Open Studio in 

order to avoid language conflicts.
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If you already used Talend Open Studio and want to import projects from a previous release, 
see How to import a project on page 14.

2.4.2 How to import the Demo project

In Talend Open Studio, you can import the Demos project that includes numerous samples of ready 
to use Jobs. This Demo project can help you understand the functionalities of different Talend 
components.

• From the Or list on the login window of Talend Open Studio, select Import demo 
project then click Go. The [Import demo project] dialog box displays

• Select your preferred language between Perl and Java and then click Finish to close the 
dialog box.

A confirmation message displays to say that the Demo project has been successfully imported in the 
current instance of the Studio.

• Click Ok to close the confirmation message. The imported Demo project displays in the Or 
list on the login window.

To open the imported Demo project in Talend Open Studio, select it from the Or list and then 
click Open. A generation engine initialization window displays. Wait till the initialization is 
complete.

The Job samples in the open Demo project are automatically imported into your workspace 
directory and made available in the Repository tree view under the Job Designs folder. 

You can use these samples to get started with your own job design.

2.4.3 How to import a project

In Talend Open Studio, you can import projects you already created with previous releases of the 
Studio.

• From the Or list on the login window of Talend Open Studio, select Import existing 
project(s) then click Go. The [Import] wizard displays.
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• Click Import several projects if you intend to import more than one project simultaneously.

• Click Select root directory or Select archive file depending on the source you want to 
import from.

• Click Browse... to select the workspace directory/archive file of the specific project folder. 
By default, the workspace in selection is the current release’s one. Browse up to reach the 
previous release workspace directory or the archive file containing the projects to import.

• Select the Copy projects into workspace check box to make a copy of the imported project 
instead of moving it. 

If you want to remove the original project folders from the Talend Open Studio 
workspace directory you import from, clear this check box. But we strongly 
recommend you to keep it selected for backup purposes.

• From the Projects list, select the projects to import and click Finish to validate the operation.

In the login window, the name(s) of the imported project(s) now display(s) in the Or list.
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You can now select the name of the imported project you want to open in Talend Open Studio 
and click Open to launch the Studio.

A generation initialization window might come up when launching the application. 
Wait until the initialization is complete.

2.4.4 How to open a project

When you launch Talend Open Studio for the first time, no project name displays 
on the Or list. You need first to create a project or import a local or Demo project in 
order to populate the Or list with the corresponding project names that you can then 

open in the Studio.

To open a project in Talend Open Studio:

• On the Studio login window, click the refresh button to update the list of projects then choose 
the relevant project name and click Open.

A progress bar displays then Talend Open Studio main window opens. A generation engine 
initialization dialog bow displays. Wait till the initialization is complete.

2.4.5 How to delete a project

• From the Or list on the Studio login window, select Delete local project(s) and then click 
Go to open the [Select Project] dialog box.
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• Select the check box(es) of the project(s) you want to delete.

• Click OK to validate the deletion. 
The project list on the login window is refreshed accordingly.

Be careful, this action is irreversible. When you click OK, there is no way to recuperate the deleted 
project(s).

If you select the Do not delete projects physically check box, you can delete the 
selected project(s) only from the project list and still have it/them in the workspace 
directory of Talend Open Studio. Thus, you can recuperate the deleted project(s) 

any time using the Import local project(s) option on the Or list from the login window.

2.4.6 How to export a project

Talend Open Studio, allows you to export projects created or imported in the current instance of 
Talend Open Studio.

• On the toolbar of the Studio main window, click  to open The [Export Talend projects 
in archive file] dialog box. 
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• Select the check boxes of the projects you want to export. You can select only parts of the 
project through the Filter Types... link, if need be (for advanced users).

• In the To archive file field, type in the name of or browse to the archive file where you want 
to export the selected projects.

• In the Option area, select the compression format and the structure type you prefer.

• Click Finish to validate the changes.

The archived file that holds the exported projects is created in the defined place.

2.5 Describing the GUI

Talend Open Studio opens on a multi-panel window. 
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Talend Open Studio main window is composed of the following elements:

• Tools bar and menus

• Repository

• Design workspace

• Various configuration views in a tab system

• Outline view and Code Viewer

The various panels and their respective features are detailed hereafter.

2.5.1 Toolbar and Menus

At the top of Talend Open Studio main window, a tool bar as well as various menus gather Talend 
commonly features along with some Eclipse functions.

Quick access toolbar

The toolbar allows you to quickly access the most commonly used functions. It slightly differs 
if you work at a Job or a Business Model.
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The toolbar allows a quick access to the following actions:

Menus

Talend Open Studio’s menus include:

• some standard functions, such as Save, Print, Exit, which are to be used at the 
application level.

• some Eclipse native features to be used mainly at the design workspace level as well as 
specific Talend Open Studio functions.

The below table describes menus and menu items available to you on the menu bar of Talend 
Open Studio.

Name Icon Description

Save Saves current job design.

Export items Exports repository items to an archive file, for deploying outside 
Talend Open Studio. Instead if you intend to import the exported 
element into a newer version of Talend Open Studio or of another 
workstation, make sure the source files are included in the archive.

Import items Imports repository items from an archive file into your current 
Talend Open Studio. For more information regarding the 
import/export items feature, see Importing items on page 182.

Find a specific 
job

Displays the relevant dialog box that enables you to open any Job 
listed in the Repository tree view.

Run job Executes the Job currently shown on the design space. For more 
information about job execution, see Running a Job on page 126.

Create Launches the relevant creation wizard. Through this menu, you can 
create any repository item: a Business model, a Job Design, a 
context, a routine, a metadata entry, and so on.

Project settings Launches the [Project Settings] dialog bow. From this dialog box, 
you can add a description to the current Project and customize the 
Palette display. For more information., see Customizing project 
settings on page 44.

Export Talend 
projects

Launches the [Export Talend projects] wizard. For more 
information about project export, see How to export a project on 
page 17

Detect and 
update all jobs

Searches for all updates available for your 

Undo/Redo Redoes or undoes the last action you performed.

Toggle subjobs Maintain or remove the background color of all your subjobs. For 
more information, see Removing the subjob background color on 
page 81.

Zoom in/out Select the zoom percentage to zoom in or zoom out on your Job.
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Menu Menu item Description

File Close Closes the current open view on the Studio design workspace.

Close All Closes all open views on the Studio design workspace.

Save Saves any changes done in the current open view.

Save All Saves any changes done in all open views.

Print .Unavailable option.

Switch project Closes the current session and launches another one to enable 
you to open a different project in the Studio.

Edit project 
properties

Opens a dialog box where you can customize the settings of the 
current project. 
For more information, see Customizing project settings on page 44

Import Opens a wizard that helps you to import different types of resources 
(files, items, preferences, XML catalogs, etc.) from different 
sources.

Export Opens a wizard that helps you to export different types of resources 
(files, items, preferences, breakpoints, XML catalogs, etc.) to 
different destinations.

Exit Closes The Studio main window.

Open File Opens a file from within the Studio.

Edit Undo Undoes the last action done in the Studio design workspace.

Redo Redoes the last action done in the Studio design workspace.

Cut Cuts selected object in the Studio design workspace.

Copy Copies the selected object in the Studio design workspace.

Paste Pastes the previously copied object in the Studio design workspace.

Delete Deletes the selected object in the Studio design workspace.

Select All Selects all components present in the Studio design workspace.

Window Perspective Opens different perspectives of different items in the list.

Show View... Opens the [Show View] dialog box which enables you to display 
different views on the Studio.

Maximize 
Active View or 
Editor...

Maximizes the current perspective.

Preferences Opens the [Preferences] dialog box which enables you to set your 
preferences. 
For more information about preferences, see Setting Talend Open 
Studio preferences on page 35.

Help Welcome Opens a welcoming page which has links to Talend Open Studio 
documentation and Talend practical sites.

Help Contents Opens the Eclipse help system documentation.
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2.5.2 Repository tree view

The Repository tree view gathers all the technical items that can be used either to describe business 
models or to design Jobs. It gives access to Business Models, JobDesigns, as well as reusable 
routines or documentation. 

The Repository centralizes and stores all necessary elements for any job design and business 
modeling contained in a project.

The Repository tree view shows a hierarchical presentation of the following nodes:

Business Models

Under the Business Models node, are grouped all business models of the project. Double-click 
the name of the model to open it on the design workspace.

Related topic: Designing a Business Model on page 53

Job Designs

The Job Designs node shows all job flowcharts designed for the current project. Double-click 
the name of the flowcharts to open it on the design workspace.

About Talend 
Open Studio

Displays: 
  
-the software version you are using 
-detailed information on your software configuration that may be 
useful if there is a problem 
-detailed information about plug-in(s) 
-detailed information about Talend Open Studio features.

Export logs Opens a wizard that helps you to export all logs generated in the 
Studio and system configuration information to an archived file.

Software 
Updates

Find and Install...: Opens the [Install/Update] wizard that helps 
searching for updates for the currently installed features, or 
searching for new features to install.

Manage Configuration...: Opens the [Product Configuration] 
dialog box where you can manage Talend Open Studio 
configuration.

Menu Menu item Description

The refresh button allows you to update the tree view with the 
last changes made.

The Repository tree view stores all your data (BMs, JDs, SQL 
templates) and metadata (Routines, snippets, DB/File 
connections, any meaningful Documentation and so on).
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Related topic: Designing a Job on page 65.

Contexts

The Context node groups files holding the contextual variables that you want to reuse in various 
Jobs, such as filepaths or DB connection details.

Related topic: Defining Contexts and variables on page 116

Code

The Code node is a library that groups the routines available for this project as well as snippets 
(to come) and other pieces of code that could be reused in the project.

click the relevant tree entry to expand the appropriate code piece.

Related topic: Designing a Job on page 65

Routines

A Routine is a piece of code which can be iterative in a technical Job hence is likely to be 
reused several times within the same project.

Under Routines, a System folder groups all Talend pre-defined routines. expanding this 
node again in the Repository, various routine files display such as Dates, Misc and String 
gathering default pieces of codes according to their nature. 

Double-click the file. The Routines editor opens up as a new tab and can be moved around 
the design workspace by simply holding down the mouse and releasing at the target 
location.

Use these routines as reference for building your own or copy the one you need into the 
relevant properties field of your Job.

To create a new routine, right-click the Routines entry of the Repository, and select Create 
a routine in the pop-up menu. The routine editor opens up on a template file containing a 
default piece of code such as: 

sub printTalend {

     print "Talend\n"

Replace it with your own and when closing it, the routine is saved as a new node under 
Routines. 

You can also create directories to classify the user’s routines.

 
The System folder, along with its content is read-only.

SQL Templates

The SQL Templates node groups all system SQL templates and gives the possibility to create 
user-defined SQL templates.

Related topic: Using SQL Templates on page 90.
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Metadata

The Metadata folder bundles files holding redundant information you want to reuse in various 
Jobs, such as schemas and property data.

Related topic: Defining Metadata items on page 92

Documentation

The Documentation directory gathers all types of documents, of any format.This could be, for 
example, specification documents or a description of technical format of a file. Double-click to 
open the document in the relevant application.

Related topic: Generating HTML documentation on page 134

Recycle bin

Drop elements from the Repository tree view to the recycle bin or press del key to get rid of 
irrelevant or obsolete items.

The deleted elements are still present on your file system, in the recycle bin, until 
you right-click the recycle bin icon and select Empty Recycle bin.

2.5.3 Design workspace   

The Design workspace is Talend Open Studio’s flowcharting editor, where both business 
models as well as job designs can be laid out.

You can open and edit both, job designs and business models, in this single graphical editor. Active 
designs display in a easily accessible tab system.

A Palette is docked at the top of the design workspace to help you draw the model corresponding 
to your workflow needs.
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2.5.4 Palette

From the Palette, depending on whether you are designing a Job or modeling a Business Model, 
drop shapes, branches, notes or technical components to the design workspace. Define and format 
them using the various tools offered in the Business Model panel for the Business Models and in 
the Component panel for the Job Designs.

Related topics: 

• Designing a Business Model on page 53

• Designing a Job on page 65

Personalizing the Palette layout

You can modify the Palette and components layout according to your needs.

Changing the Palette position

If the Palette doesn’t show or if you want to set it apart in a panel, right-click the Palette 
bar and select Detached from the contextual menu. The Palette opens in a separate view 
that you can move around wherever you like within Talend Open Studio’s main window.

Changing the Palette layout and settings

You can change the layout of the component list in the Palette to display them in columns 
or in lists, as icons only or as icons with short description. 

You can also enlarge the component icons for better readability of the component list.

To do so, right-click any component family in the Palette and select the desired option in 
the contextual menu or click Settings to open the [Palette Settings] window and fine-tune 
the layout.

Display/hide components families

You can display/hide components families according to your needs in case of visibility 
problems, for example. To do so, right-click the Palette and select Display folder to display 
components families and Hide folder to display components without their families.
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This display/hide option can be very useful when you are in the Favorite 
view of the Palette. In this view, you usually have a limited number of 
components that if you display without their families, you will have them in 

an alphabetical list and thus facilitate their usage. for more information about the 
Palette favorite, see Palette favorite on page 28.

Maintaining a component family open on the Palette

If you often use one or many component families, you can add a pin on their names to stop 
them from collapsing when you select components from other families.

To add a pin, click the pin icon on the top right-hand corner of the family name.

Using the Palette

The Palette offers you search and favorite possibilities that by turn facilitate its usage.

Searching components

You can search a component in the search field at the top of the Palette.

To search for a component, do the following:

• Click  to clear the search field of any text.

• Enter the name of the component you want to look for and click OK.

The Palette displays only the family/families that hold(s) the component. 

To go back to the default Palette settings, click .

Searching for Jobs that use specific components

From the Palette, you can search for Jobs that use a specific component. To do so:
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You should open one Job at least in the Studio to display the Palette to the 
right of the design workspace and thus start the search.

• In the Palette, right-click the component you look for and select Find Component 
in Jobs.

A progress indicator displays to show the percentage of the search operation that has been 
completed then the [Find a Job] dialog box displays listing all the Jobs that use the selected 
component.
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• From the list of Jobs, click the desired Job and then click OK to open it on the design 
workspace.

Palette favorite

You can add/remove components to/from the Palette favorite view of Talend Open 
Studio in order to have a quick access to all the components that you mostly use.

To do so:

• From the Palette, right-click the component you want to add to Palette favorite and 
select Add To Favorite.

• Do the same for all the components you want to add to the Palette favorite then click 
the Favorite  button in the upper right corner of the Palette to display the Palette 
favorite.

Only the components added to the favorite are displayed.

To delete a component from the Palette favorite:
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• Right-click the component you want to remove from the favorite and select Remove 
From Favorite.

To restore the Palette standard view, click the Standard  button in the upper right corner 
of the Palette.

2.5.5 Configuration tab system

The Component, Run Jobs, Problems and Error Log tabs gather all information relative to the 
graphical elements in selection in the design workspace or the actual execution of a complete Job.

The Modules and Scheduler tabs are located in the same tab system as the Component, Logs and 
Run Job tabs. Both views are independent from the active or inactive Jobs open on the design 
workspace. 

Job view

The Job view displays various information related to the open Job on the design workspace. 

Main tab

The Main tab displays basic information about the Job opened on the design workspace, i.e. 
its Name, Author, Version number, etc. The information is read-only, to edit it you have 
to close your Job, right-click its label on the Repository tree view and click Edit properties 
on the drop-down list.

Extra tab

The Extra tab displays extra parameters including multi thread and implicit context loading 
features. For more information, see Extra features on page 137.

Stats/Logs tab

The Stats/Log tab allows you to enable/disable the statistics and logs for the whole Job.

You can already enable these features for every single component of your Job by simply 
using and setting the relevant components:  tFlowMeterCatcher, tStatCatcher, 
tLogCatcher.

For more information about these components, see tFlowMeterCatcher, tLogCatcher and 
tStatCatcher in Talend Open Studio Components Reference Guide.

In addition, you can now set these features for the whole active Job (i.e. all components of 
your Job) in one go, without using the Catcher components mentioned above. This way, all 
components get tracked and logged in the File or Database table according to your setting.

You can also set the current setting as preference by clicking the relevant button.

For more details about the Stats & Logs automation, see Automating statistics & logs use on 
page 136.

Version tab

The Version tab displays the different versions of the Job opened on the design workspace 
and their creation and modification dates.
Creative Commons License Talend Open Studio 29

http://creativecommons.org/licenses/by-nc-sa/2.0/


Getting started with Talend Open Studio
Describing the GUI
Component view

The Component view details the parameters specific to each component of the Palette. To build 
a Job that will function, you are required to fill out the necessary fields of this Component view 
for each component forming your Job.

For more information about the Component view, see Defining the component properties on 
page 82.

Run Job view

The Run Job tab obviously shows the current job execution. This tab becomes a log console at 
the end of an execution.

For details about the job execution, see Running a Job on page 126.

Error Log

The Error Log is mainly used for job execution errors. This view shows the history of warnings 
or errors occurring during job executions.

The log tab has also an informative function for Perl/Java component operating 
progress, for example.

The Error Log tab is hidden by default. As for any other view, go to Window > Show views, 
then expand PDE Runtime node and select Error Log to display it on the tab system. 

Modules view

The use of some components requires specific Perl modules to be installed, check the Modules 
view, what modules you have or should have to run smoothly your Jobs.

If the Modules tab doesn’t show on the tab system of your design workspace, go to Window > 
Show View... > Talend, and select Modules in the expanded Talend node. 

The view shows if a module is necessary and required for the use of a referenced component.

The Status column points out if the modules are yet or not yet installed on your system. The 
warning triangle icon indicates that the module is not necessarily required for this component.

For example, the DBD::Oracle module is only required for using tDBSQLRow if the latter is 
meant to run with Oracle DB. The same way, DBD::Pg module is only required if you use 
PostgreSQL. But all of them can be necessary.
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The red crossed circle means the module is absolutely required for the component to run.

If the Context column is empty, the module is then required for the general use of Talend 
Open Studio.

To install any missing Perl module, refer to the relevant installation manual on 
http://talendforge.org/wiki/

Open Scheduler view

The Open Scheduler is based on the crontab command, found in Unix and Unix-like operating 
systems. This cron can be also installed on any Windows system.

Open Scheduler generates cron-compatible entries allowing you to launch periodically a Job via 
the crontab program.

If the Scheduler tab doesn’t display on the tab system of your design workspace, go to Window 
> Show View... > Talend, and select Scheduler in the expanded Talend node. 

Set the time and comprehensive date details to schedule the task. 

Open Scheduler automatically generates the corresponding task command that will be added to 
the crontab program.

Talend Exchange view

Talend Open Studio enables you to access a list of all community components in Talend 
Exchange that are compatible with your current version of Talend Open Studio and are not 
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yet installed in your Palette. You can then download these components to use them later in the 
job designs you carry out in the Studio.

The community components available for download in Talend Exchange view 
are not validated by Talend. This explains the component-load errors you may 
have sometimes when trying to download certain components from the view.

Installing community components from Talend Exchange

To copy community components from Talend Exchange onto the Palette of your current 
Talend Open Studio:

• Click the Talend Exchange tab in the lower part of Talend Open Studio to open 
the Compatible components list. 
This list is empty till you click the refresh button in the upper right corner of the view.

• Click the refresh button in the upper right corner of the view. 
Components from Talend Exchange that are compatible with your current version 
of Talend Open Studio display.

• Click the install button  next to the component name you want to load to the 
Palette. 
A progress indicator displays to show the percentage of the download process that 
has been completed. When the component is successfully installed, a confirmation 
dialog box displays to confirm the download operation and indicate where in the 
Palette the component has been loaded.

To download a group of selected components simultaneously, select the 
components to download and click the install button in the upper right corner 
of the view.

• Click OK in the confirmation dialog box to close it and restart Talend Open 
Studio.  
All downloaded components display in their relative families in the Palette.

You can also download components compatible with older versions of Talend Open 
Studio. To do so:

• On the Talend Exchange view, select the desired version from the Talend Studio 
version filter list. The Compatible components list is refreshed automatically.
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Managing installed components

From the Talend Exchange view, you can reload or delete components you already 
installed in the Palette.

To install the updated version of a component you already downloaded from the 
Compatible components list, do as follows:

• In the upper left corner of the view, click the Installed components tab to open a 
list of all the components you downloaded from Talend Exchange.

• Click the refresh button  next to the component name for which you want to 
install the newer version.

If the already downloaded community component is modified in Talend 
Exchange, the refresh button next to its name will become blue in color. 
Otherwise, it is grey. 

To delete a component that you previously downloaded from the Compatible components 
list, do as follows:

• In the Installed components list, click the remove button  next to the 
component name you want to delete from your system. You will always be able to 
re-install it later if you feel like.

Problems view

The Problems tab displays the message linked to the icons docked at the components when part 
of the setting is missing. Check the Description of the Error, Warning and/or Info icons.
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Job Hierarchy view

The Job Hierarchy view displays a tree folder showing the child Job(s) of the parent Job 
selected. To show this view, right-click the parent Job in the Repository and select Open Job 
Hierarchy on the drop-down list.

You can also show this view in the Window > Show view... combination where you can select 
Talend > Job Hierarchy.

You can see Job Hierarchy only if you create a parent Job and one or more child Job(s) via the 
tRunJob component. For more information about tRunJob, see tRunJob in Talend Open 
Studio Components Reference Guide.

Properties view

When inserting a shape in the design workspace, the Properties tab offers a range of formatting 
tools to help you customize your business model and improve the readability of the whole 
business model.

2.5.6 Outline and Code Summary panel 

The Information panel is composed of two tabs, Outline and Code Viewer, which provide 
information regarding the displayed diagram (either Job Design or Business Model).

Outline

The Outline tab offers a quick view of the business model or job design open on the design 
workspace and a tree view of variables. As the design workspace, like any other window area 
can be resized upon your needs. The Outline view is convenient to check out where about on 
your design workspace, you are located.
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 This graphical representation of the diagram 
highlights in a blue rectangle the diagram part 
showing in the design workspace.

Click the blue-highlighted view and hold down the 
mouse button. Then, move the rectangle over the 
Job. 

The view in the design workspace moves 
accordingly.

The Outline view can also be displaying a folder 
tree view of components in use in the current 
diagram. Expand the node of a component, to show 
the list of variables available for this component. 

To switch from the graphical outline view to the 
tree view, click either icon docked at the top right 
of the panel. 

Code viewer

The Code viewer tab provides lines of code 
generated for the selected component, behind the 
active job design view, as well the run menu 
including Start, Body and End elements.

 
This view only concerns the job design code, as no code is generated from 
business models.

Using a graphical colored code view, the tab shows the code of the component selected in the 
design workspace. This is a partial view of the primary Code tab docked at the bottom of the 
design workspace, which shows the code generated for the whole Job.

2.6 Setting Talend Open Studio preferences

You can define various properties of Talend Open Studio main design workspace according to your 
needs and preferences. 

Numerous settings you define can be stored in the Preference and thus become your default values for 
all new Jobs you create.

The following sections describe specific settings that you can set as preference.

First, click the Window menu of your Talend Open Studio, then select Preferences.

2.6.1 Perl/Java Interpreter path

In the preferences, you might need to let Talend Open Studio pointing to the right interpreter path, 
Perl or Java.

• If needed, click the Talend node in the tree view of the [Preferences] dialog box. 
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• Enter a path to the Perl/Java interpreter if the default directory does not display the right path.

On the same view, you can also change the preview limit and the path to the temporary files or the 
OS language.

2.6.2 External or User components

You can create/develop your own components and use them in Talend Open Studio. 

For more information about the creation and development of user components, refer to our wiki 
Component creation tutorial section.

In the tree view of the [Preferences] dialog box, expand the Talend node and select Components.

• Fill in the User components folder path or browse to the folder that holds the components 
to be added to the Palette of Talend Open Studio.

•  Restart Talend Open Studio for the components to show in the Palette in the location that 
you defined.

• In the Default mapping links display as list, select the mapping link type you want to use 
in the tMap.
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• Select the Don’t show corresponding job after double click on a tRunJob component 
check box if you do not want that the child Job called by the tRunJob component opens 
when you double click the component.

2.6.3 Language preferences

You can set language preferences in Talend Open Studio. To do so:

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend node and click Internationalization to display the relevant view.

• From the Local Language list, select the language you want to use for Talend Open Studio 
graphical interface.

• Click Apply and then OK to validate your change and close the [Preferences] dialog box.

• Restart Talend Open Studio to display the graphical interface in the selected language.

The Import all translations and Import only validated translations buttons are for 
translators who use Babili, our translation portal, at : 
http://www.talendforge.org/babili/.

2.6.4 Debug and job execution preferences

You can set your preferences for debug and job executions in Talend Open Studio. To do so:

• On the menu bar, click Window > Preferences to display the [Preferences] dialog box.

• Expand the Talend node and click Run/Debug to display the relevant view.
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In the Talend client configuration area, you can define the execution options to be used by default:

• In the Stats port range fields, you can specify a range for the ports used for generating 
statistics. In particular, if the ports defined by default are used by other applications.

• In the Trace port range fields, you can specify a range for the ports used for generating 
traces. In particular, if the ports defined by default are used by other applications.

• Select the Save before run check box to automatically save our Job before its execution.

• Select the Clear before run check box to delete the results of a previous execution before 
re-executing the Job.

• Select the Exec time check box to show job execution duration.

• Select the Statistics check box to show the statistics measurement of data flow during job 
execution.

• Select the Traces check box to show data processing during job execution.

• In the Pause time field, enter the time you want to set before each data line in the traces table.

• In the Job Run VM arguments list, you can define the parameter of your current JVM 
according to your needs. The by-default parameters -Xms256M and -Xmx1024M 
correspond respectively to the minimal and maximal memory capacities reserved for your 
job executions.

For more information about possible parameters, check the site 
http://java.sun.com/javase/technologies/hotspot/vmoptions.jsp.

2.6.5 Designer preferences

You can set component and job design preferences to let your settings be permanent in the Studio.
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• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend > Appearance node.

• Click Designer to display the corresponding view.

On this view, you can define the way component names and hints will be displayed. 

Select the relevant check boxes to customize your use of Talend Open Studio design workspace. 

2.6.6 Adding code by default

You can add pieces of code by default at the beginning and at the end of the code of your Job.

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend and Import/Export nodes in succession and then click Shell Setting to 
display the relevant view.

• In the Command field, enter your piece/pieces of code before or after 
%GENERATED_TOS_CALL% to display it/them before or after the code of your Job.
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2.6.7 Performance preferences

You can set the Repository tree view preferences according to your use of Talend Open Studio. To 
refresh the Repository view:

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend node and click Performance to display the repository refresh preference.

Set the refresh preferences according to your use of Talend Open Studio. In the Repository 
Refresh area:

• Select the Refresh Manually check box to refresh manually the Repository view. Note that 
this option deactivates the other boxes.

• Select the Refresh when creating an item check box to refresh the Repository tree view 
each time you create a new item (Business Model, Job, Routine, Metadata and so on).

• Select the Refresh when saving an item check box to refresh the Repository tree view each 
time you save an item.

• Select the Refresh when deleting an item check box to refresh the Repository tree view 
each time you delete an item.

 
You can improve your performance when you deactivate automatic refresh.

Set the performance preferences according to your use of Talend Open Studio:

• Select the Deactivate auto detect/update after a modification in the repository check box 
to deactivate the automatic detection and update of the Repository.

• Select the Check the property fields when generating code check box to activate the audit 
of the property fields of the component. When one property filed is not correctly filled in, 
the component is surrounded by red on the design workspace.
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You can optimize performance if you disable property fields verification of 
components, i.e. if you clear the Check the property fields when generating code 
check box.

• Select the Generate code when opening the job check box to generate code when you open 
a job.

• Select the Check only the last version when updating jobs or joblets check box to only 
check the latest version when you update a job or a joblet.

• Select the Propagate add/delete variable changes in repository contexts to propagate 
variable changes in the Repository Contexts.

• Select the Activate the timeout for database connection check box to establish database 
connection time out. Then set this time out in the Connection timeout (seconds) field.

2.6.8 Documentation preferences

You can include the source code on the generated documentation.

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend node and click Documentation to display the documentation 
preferences.

• Select the Source code to HTML generation check box to include the source code in the 
HTML documentation that you will generate.

2.6.9 SQL Builder preferences

You can set your preferences for the SQL Builder. To do so:

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend and Specific Settings nodes in succession and then click Sql Builder to 
display the relevant view.

• Select the add quotes, when you generated sql statement check box to precede and follow 
column and table names with inverted commas in your SQL queries.
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• In the AS400 SQL generation area, select the Standard SQL Statement or System SQL 
Statement check boxes to use standard or system SQL statements respectively when you use 
an AS400 database.

• Clear the Enable check queries in the database components (disable to avoid warnings 
for specific queries) check box to deactivate the verification of queries in all database 
components.

2.6.10 Schema preferences

You can define the default data length and type of the schema fields of your components.

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend node and click Default Type and Length to display the data length and 
type of your schema.

Set the parameters according to your needs:

• In the Default Settings for Fields with Null Values area, fill in the data type and the field 
length to apply to the null fields.

• In the Default Settings for All Fields area, fill in the data type and the field length to apply 
to all fields of the schema.

• In the Default Length for Data Type area, fill in the field length for each type of data.
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2.6.11 Libraries preferences

You can define the folder where to store the different libraries used in Talend Open Studio. To do 
so:

• On the menu bar, click Window > Preferences to display the [Preferences] dialog box.

• Expand the Talend and Specific Settings nodes in succession and then click Libraries to 
display the relevant view.

• In the Folder selection mode area, select the Same root folder check box to store the Java 
and Perl libraries in the same folder. You can set the access path in the External libraries 
path field through the Browse... button.

• If you prefer to store the Java and Perl libraries in two different folders, select the check box 
A root folder for each language and set the access paths in the External java libraries 
path and External perl libraries path for Java and Perl libraries respectively.

2.6.12 Type conversion

You can set the parameters for type conversion in Talend Open Studio, from Java towards 
databases and vice versa.

• On the menu bar, click Window > Preferences to display the [Preferences] dialog box.

• Expand the Talend and Specific Settings nodes in succession and then click Metadata of 
Talend Type to display the relevant view.

The Metadata Mapping File area lists the XML files that hold the conversion parameters for each 
database type used in Talend Open Studio.

• You can import, export, or delete any of the conversion files by clicking Import, Export or 
Remove respectively.
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• You can modify any of the conversion files according to your needs by clicking the Edit 
button to open the [Edit mapping file] dialog box and then modify the XML code directly 
in the open dialog box.

2.7 Customizing project settings

Talend Open Studio enables you to customize the information and the settings of the current project, 
including Palette and job settings, job version management and so on.

2.7.1 Palette Settings

To customize the Palette display:

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

In the General view of the [Project Settings] dialog box, you can add a description 
to your current project if you have not done so when creating the project.

• In the tree view of the [Project Settings] dialog box, expand Designer and select Palette 
Settings. The settings of the current Palette display in the panel to the right of the dialog box.

• Select a component or groups of components to remove from the current Palette. 

• Then use the left arrow button to move the selection onto the panel to the left. This will 
remove the selected components from the Palette of the current instance of the Studio.
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• To display again hidden components, select them from the left panel and use the right arrow 
button to restore them in the Palette. 

• Click Apply to validate your changes and OK to close the dialog box. 

 
To get back to the Palette default setting, click Restore Defaults.

2.7.2 Version management

You can also manage the version of each item in the Repository tree view through General > 
Version Management of the [Project Setting] dialog box.

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, expand General and select Version Management to open 
the corresponding view.
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• In the Repository tree view, expand the node holding the item you want to manage their 
versions and then select the check boxes of these items. 
The selected items display in the Items list to the right along with their current version in the 
Version column and the new version set in the New Version column.

• In the Options area, select the Change all items to a fixed version check box to change the 
version of the selected items to the same fixed version.

• Click Revert if you want to undo the changes.

• To increment each version of the items, select the Update the version of each item check 
box and change them manually.

• Click Apply to apply your changes and then OK to close the dialog box.

For more information on version management, see Managing Job versions on 
page 73.

2.7.3 Job Settings

You can automatically use Implicit Context Load and Stats and Logs settings you defined in the 
[Project Settings] dialog box of the actual project when you create a new job. To do so:

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, click the Job Settings node to open the corresponding 
view.

• Select the Use project settings when create a new job check boxes of the Implicit Context 
Load and Stats and Logs areas.

• Click Apply to validate your changes and then OK to close the dialog box.
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2.7.4 Stats & Logs

When you execute a Job, you can monitor the execution through the tStatCatcher Statistics option 
or through using a log component. This will enable you to store the collected log data in .csv files 
or in a database.

You can then set up the path to the log file and/or database once for good in the [Project Settings] 
dialog box so that the log data get always stored in this location.

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, expand the Job Settings node and then click Stats & Logs 
to display the corresponding view.

If you know that the preferences for Stats & Logs will not change depending upon the 
context of execution, then simply set permanent preferences. If you want to apply the 
Stats & Logs settings individually, then it is better to set these parameters directly onto 

the Stats & Logs view. For more information about this view, see Automating statistics & logs 
use on page 136.

• Select the Use Statistics, Use Logs and Use Volumetrics check boxes where relevant, to 
select the type of log information you want to set the path for.

• Select a format for the storage of the log data: select either the On Files or On Database 
check box. Or select the On Console check box to display the data in the console.
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The relevant fields are enabled or disabled according to these settings. Fill out the File Name 
between quotes or the DB name where relevant according to the type of log information you 
selected.

You can now store the database connection information in the Repository. Set the Repository Type 
to Repository and browse to retrieve the relevant connection metadata. The fields get automatically 
completed.

Alternatively, if you save your connection information in a Context, you can also 
access them through Ctrl+Space.

2.7.5 Context settings

You can define default context parameters you want to use in your Jobs.

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, expand the Job Settings node and then select the Implicit 
Context Load check box to display the configuration parameters of the Implicit 
tContextLoad feature.

• Select the From File or From Database check boxes according to the type of file you want 
to store your contexts in.

• For files, fill in the file path in the From File field and the field separator in the Field 
Separator field.

• For databases, select the Built-in or Repository mode in the Property Type list and fill in 
the next fields.

• Fill in the Table Name and Query Condition fields.

• Select the type of system message you want to have (warning, error, or info) in case a 
variable is loaded but is not in the context or vice versa.

• Click Apply to validate your changes and then OK to close the dialog box.
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2.7.6 Project Settings use

From the [Project Settings] dialog box, you can choose to which Job in the Repository tree view 
you want to apply the Implicit Context Load and Stats and Logs settings. To do so:

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, expand the Job Settings node and then click Use Project 
Settings to display the use of Implicit Context Load and Stats and Logs option in the Jobs.

• In the Implicit Context Load Settings area, select the check boxes corresponding to the 
Jobs in which you want to use the implicit context load option.

• In the Stats Logs Settings area, select the check boxes corresponding to the Jobs in which 
you want to use the stats and logs option.

• Click Apply to validate your changes and then OK to close the dialog box.

2.7.7 Status settings

In the [Project Settings] dialog box, you can also define the Status.

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 
Creative Commons License Talend Open Studio 49

http://creativecommons.org/licenses/by-nc-sa/2.0/


Getting started with Talend Open Studio
Customizing project settings
• In the tree view of the dialog box, click the Status node to define the main properties of your 
Repository tree view elements. 
The main properties of a repository item gathers information data such as Name, Purpose, 
Description, Author, Version and Status of the selected item. Most properties are free text 
fields, but the Status field is a drop-down list.

• Click the New... button to display a dialog box and populate the Status list with the most 
relevant values, according to your needs. Note that the Code can not be more than 
3-character long and the Label is required.

Talend makes a difference between two status types: Technical status and Documentation status.

The Technical status list displays classification codes for elements which are to be running on 
stations, such as Jobs, metadata or routines.

The Documentation status list helps classifying the elements of the repository which can be used 
to document processes (Business Models or documentation).

• Once you completed the status setting, click OK to save
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The Status list will offer the status levels you defined here when defining the main properties of your 
job designs and business models.

• In the [Project Settings] dialog box, click Apply to validate your changes and then OK to 
close the dialog box.

2.7.8 Security settings

You can hide or show your passwords on your documentations, metadata, contexts, and so on when 
they are stored in the Repository tree view.

• On the toolbar of the Studio main window, click  or click File > Edit Project Properties 
from the menu bar to open the [Project Settings] dialog box. 

• In the tree view of the dialog box, click the Security node to open the corresponding view.

• Select the Hide passwords check box to hide your password.

If you select the Hide passwords check box, your password will be hidden for all your 
documentations, contexts, and so on, as well as for your component properties when 
you select Repository in the Property Type field of the component Basic settings 

view, i.e. the screen capture below. However, if you select Built-in, the password will not be 
hidden.

• In the [Project Settings] dialog box, click Apply to validate your changes and then OK to 
close the dialog box.

2.8 Migration tasks

Migration tasks are performed to ensure the compatibility of the projects you created with a previous 
version of Talend Open Studio with the current release.

As some changes might become visible to the user, we thought we’d share these update tasks with you 
through an information window.
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Some changes that affect the usage of Talend Open Studio include, for example: 

• tDBInput used with a MySQL database becomes a specific tDBMysqlInput component the 
aspect of which is automatically changed in the Job where it is used.

• tUniqRow used to be based on the Input schema keys, whereas the current tUniqRow allows the 
user to select the column to base the unicity on.

This information window pops up when you launch the project you imported (created) in a previous 
version of Talend Open Studio.

It lists and provides a short description of the tasks which were successfully performed so that you can 
smoothly roll your projects. 
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CHAPTER 3 

Designing a Business Model 
Business models are the mechanisms through which enterprises organize themselves. They typically 
include both the systems and processes already operating in the enterprise, and the ones that will be 
needed in the future.

Designing business models in an enterprise usually lead to a higher probability of business success 
because business models can reduce the upfront investment, accelerate the revenue/receivables cash 
inflow, obtain reliable customer feedback often and earlier, and take other measures to reduce the 
investment risk. 

Talend Open Studio offers the best tool to formalize business descriptions into building blocks and 
their relationships. Talend Open Studio allows to design systems, connections, processes and 
requirements using standardized workflow notation through an intuitive graphical toolbox.

This chapter aims at business managers, decision makers or developers who want to model their 
flow management needs at a macro level.



Designing a Business Model
Objectives
3.1 Objectives

A Business Model is a non technical view of a business workflow need. 

Generally, a typical business model will include the strategic systems or processes already up and 
running in your company as well as new needs. You can symbolize these systems, processes and needs 
using multiple shapes and create the connections among them. Likely, all of them can be easily described 
using repository attributes and formatting tools.

In the design workspace of Talend Open Studio, you can use multiple tools in order to: 

• draw your business needs,

• create and assign numerous repository items to your model objects,

• define the business model properties of your model objects.

3.2 Opening or creating a business model

Open Talend Open Studio following the procedure as detailed in the paragraph Launching Talend Open 
Studio on page 6.

From the main page of Talend Open Studio, click the Business models node of the Repository tree 
view to expand the business models tree view.

Select the Expand/Collapse option of the right-click 
menu, to display all existing business models (if any). 

3.2.1Opening a business model

Double-click the name of the business model to be 
opened.

The selected business model opens up on the design 
workspace.

3.2.2Creating a business model

Right-click the Business Models node and select 
Create Business Model. 

The creation wizard guides through the steps to create a new business model.

Select the Location folder where you want the new model to be stored in. 

And fill in a Name for it. The name you allocate to the file shows as a label on a tab at the top of 
the design workspace and the same name displays under the Business Models node in the 
Repository tree view.

The Modeler opens up on the empty design workspace. 

You can create as many models as you want and open them all, they will display in a tab system on 
your design workspace. 
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The Modeler is made of the following panels:

• Talend Open Studio’s design workspace

• a Palette of shapes and lines specific to the Business modeling

• the Business Model panel showing specific information about all or part of the model.

3.3 Modeling a Business Model

If you have multiple tabs opened on your design workspace, click the relevant tab in order to show the 
appropriate model information.

In the Business Model view, you can see information relative to the active model.
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Use the Palette to drop the relevant shapes on the design workspace and 
connect them together with branches and arrange or improve the model 
visual aspect by zooming in or out. 

This Palette offers graphical representations for objects interacting within 
a business model.

The objects can be of different types, from strategic system to output 
document or decision step. Each one having a specific role in your business 
model according to the description, definition and assignment you give to it.

All objects are represented in the Palette as shapes, and can be included in 
the model.

Note that you must click the business folder to display the library of shapes 
on the Palette.

3.3.1Shapes

Select the shape corresponding to the relevant object you want to include in 
your business model. Double-click it or click the shape in the Palette and 
drop it in the modeling area.

Alternatively, for a quick access to the shape library, keep your cursor still 
on the modeling area for a couple of seconds to display the quick access 
toolbar:

For instance, if your business process includes a decision step, select the diamond shape in the 
Palette to add this decision step to your model. 

When you move the pointer over the quick access toolbar, a tooltip helps you to 
identify the shapes.

Then a simple click will do to make it show on the modeling area.

The shape is placed in a dotted black frame. Pull the corner dots to resize it as 
necessary. 

Also, a blue-edged input box allows you to add a label to the shape. Give an 
expressive name in order to be able to identify at a glance the role of this shape 
in the model.

Two arrows below the added shape allow you to create connections with other shapes. You can 
hence quickly define sequence order or dependencies between shapes. 

Related topic: Connecting shapes on page 57.

The available shapes include:
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3.3.2 Connecting shapes

When designing your business model, you want to implement relations between a source shape and 
a target shape.

There are two possible ways to connect shapes in your design workspace: 

Either select the relevant  Relationship tool in the Palette. Then, in the design workspace, pull a 
link from one shape to the other to draw a connection between them. 

 Or, you can implement both the relationship and the element to be related to or from, in few clicks. 

• Simply mouse over a shape that you already dropped on your design workspace, in order to 
display the double connection arrows. 

• Select the relevant arrow to implement the correct directional connection if need be. 

• Drag a link towards an empty area of the design workspace and release to display the 
connections popup menu. 

Callout Details

Decision The diamond shape generally represents an if condition 
in the model. Allows to take context-sensitive actions.

Action The square shape can be used to symbolize actions of 
any nature, such as transformation, translation or 
formatting.

Terminal The rounded corner square can illustrate any type of 
output terminal

Data A parallelogram shape symbolize data of any type.

Document Inserts a Document object which can be any type of 
document and can be used as input or output for the data 
processed.

Input Inserts an input object allowing the user to type in or 
manually provide data to be processed.

List forms a list with the extracted data. The list can be 
defined to hold a certain nature of data

Database Inserts a database object which can hold the input or 
output data to be processed.

Actor This schematic character symbolizes players in the 
decision-support as well technical processes 

Ellipse Inserts an ellipse shape

Gear This gearing piece can be used to illustrate pieces of code 
programmed manually that should be replaced by a 
Talend Job for example.
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• Select the appropriate connection among the list of relationships to or from. You can choose 
among simple relationship, directional relationship or bidirectional relationship.

• Then, select the appropriate element to connect to, among the items listed. 

You can create a connection to an existing element of the model. Select Existing Element in the 
popup menu and choose the existing element you want to connect to in the displaying list box.

The connection is automatically created with the selected shape.

The nature of this connection can be defined using Repository elements, and can be formatted and 
labelled in the Properties panel, see Business Models on page 60.

When creating a connection, an input box allows you to add a label to the connection you’ve created. 
Choose a meaningful name to help you identify the type of relationship you created.

You can also add note and comment to your model in order to identify elements or 
connections at a later stage.

Related topic: Commenting and arranging a model on page 59
58 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Business Model
Modeling a Business Model
3.3.3 Commenting and arranging a model

The tools of the Palette allow you to customize your model:

Adding a note or free text

To add a note, select the Note icon in the Palette, docked to the right of the design workspace.

Alternatively right-click the model or the shape you want to link the note to, and select Add 
Note. Or select the Note tool in the quick access toolbar. 

A sticky note displays on the modeling area. If the note is linked to a particular shape, a line is 
automatically drawn to the shape. 

Type in the text in the input box or, if the latter doesn’t show, type in directly on the sticky note.

If you want to link your notes and specific shapes of your model, click the 
down arrow next to the Note tool on the Palette and select Note attachment. 
Pull the black arrow towards an empty area of the design workspace, and 
release. The popup menu offers you to attach a new Note to the selected 
shape.

You can also select the Add Text feature to type in free text directly in the 
modeling area. You can access this feature in the Note drop-down menu of 
the Palette or via a shortcut located next to the Add Note feature on the quick access toolbar.  

Arranging the model view

You can also rearrange the look and feel of your model via the right-click menu.

Callout Details

Select Select and move the shapes and lines around in the 
design workspace’s modeling area.

Zoom Zoom in to a part of the model. To watch more 
accurately part of the model. To zoom out, press Shift 
and click the modeling area.

Note/Text/Note 
attachment

Allows comments and notes to be added in order to 
store any useful information regarding the model or 
part of it. 
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Place your cursor in the design area, right-click to 
display the menu and select Arrange all. The shapes 
automatically move around to give the best possible 
reading of the model.

Alternatively, you can select manually the whole 
model or part of it. 

To do so, right-click any part of the modeling area, 
and click Select. 

You can select:

• All shapes and connectors of the model, 

• All shapes used in the design workspace,

• All connectors branching together the shapes.

From this menu you can also zoom in and out to part 
of the model and change the view of the model.

3.3.4 Business Models

The information in the Business Models view corresponds to the current selection, if any. This can 
be the whole model if you selected all shapes of it or more specifically one of the shapes it is made 
of. If nothing is selected, the Business Models tab gives general information about the model.

The Business Models view contains different types of information grouped in the Main, 
Appearance, Rules & Grid, and Assignment tabs.

The Main tab displays basic information about the selected item in the design workspace, being a 
Business Model or a Job. For more information about the Main tab, see Main tab on page 29.

Appearance tab

 From the Appearance tab you can apply filling or border colors, change the appearance of 
shapes and lines in order to customize your business model or make it easier to read.

The Business Model view includes the following formats:

• fill the shape with selected color. 

• color the shape border

• insert text above the shape

• insert gradient colors to the shape

• insert shadow to the shape

You can also move and manage shapes of your model using the edition tools. Right-click the 
relevant shape to access these editing tools. 

Rulers and Grid tab

To display the Rulers & Grid tab, click the Select tool on the Palette, then click any empty area 
of the design workspace to deselect any current selection. 
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Click the Rulers & Grid tab to access the ruler and grid setting view.

In the Display area, select the Show Ruler check box to show the Ruler, the Show Grid check 
box to show the Grid, or both heck boxes. Grid in front sends the grid to the front of the model. 

In the Measurement area, select the ruling unit among Centimeters, Inches or Pixels.

In the Grid Line area, click the Color button to set the color of the grid lines and select their 
style from the Style list. 

Select the Snap To Grid check box to bring the shapes into line with the grid or the Snap To 
Shapes check box to bring the shapes into line with the shapes already dropped in the Business 
Model. 

You can also click the Restore Defaults button to restore the default settings.

Assignment tab

The Assignment tab displays in a tabular form details of the Repository attributes you allocated 
to a shape or a connection. 

To display any assignment information in the table, select a shape or a connection in the active 
model, then click the Assignment tab in the Business Model view. 
Creative Commons License Talend Open Studio 61

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Business Model
Assigning Repository elements to a Business Model
You can also display the assignement list placing the mouse over the shape you assigned 
information to. 

You can modify some information or attach a comment. Also, if you update data from the 
Repository tree view, assignment information gets automatically updated.

For further information about how to assign elements to a Business Model, see Assigning 
Repository elements to a Business Model on page 62.

3.4 Assigning Repository elements to a Business Model

The Assignment tab in the Business Models view lists the elements from the Repository tree view 
which have been assigned to a shape in the Business Model.

You can define or describe a particular object in your Business 
Model by simply associating it with various types of 
information, i.e. by adding metadata items. 

You can set the nature of the metadata to be assigned or 
processed, thus facilitating the job design phase.

To assign a metadata item, simply drop it from the Repository 
tree view to the relevant shape in the design workspace.

The Assignment table, located underneath the design 
workspace, gets automatically updated accordingly with the 
assigned information of the selected object. 

The types of items that you can assign are:
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For more information about the Repository elements, see Designing a Job on page 65

3.5 Editing a business model

Follow the relevant procedure according to your needs:

3.5.1 Renaming a business model

Right-click the relevant Business Model label on the Repository tree viewl then select Edit 
properties to display the corresponding Main properties information in the [Edit properties] 
dialog box.

Edit the model name in the Name field, then click Finish to close the dialog box. The model label 
changes automatically in the Repository tree view and will be reflected on the model tab of the 
design workspace, the next time you open the Business Model.

If the Business Model is open, the information in the [Edit properties] dialog box will 
be read-only so you won’t be able to edit them. 

3.5.2 Copying and pasting a business model

In Repository > Business model, right-click the business model name to be copied and select Copy 
in the popup menu, or press Ctrl+c.

Then right-click where you want to paste your business model, and select Paste. 

3.5.3 Moving a business model

To move a business model from a location to another in your business models project folder, select 
a business model in the Repository > Business Models tree.

Then simply drop it to the new location.

Element Details

Job designs If any job designs developed for other projects in the same repository are 
available, you can reuse them as metadata in the active Business Model 

Metadata You can assign any descriptive data stored in the repository to any of the 
objects used in the model. It can be connection information to a database 
for example.

Business Models You can use in the active model all other Business Models stored in the 
repository of the same project.

Documentation You can assign any type of documentation in any format. It can be a 
technical documentation, some guidelines in text format or a simple 
description of your databases.

Routines (Code) If you have developed some routines in a previous project, to automate 
tasks for example, you can assign them to your Business Model. Routines 
are stored in the Code folder of the Repository tree view.
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3.5.4 Deleting a business model

Right-click the name of the model to be deleted and select Delete in the popup menu. 

Alternatively, simply select the relevant Business Model, then drop it into the Recycle bin of the 
Repository tree view. 

3.6 Saving a Business Model

To save a Business Model, click File > Save or press Ctrl+s. The model is saved under the name you 
gave during the creation process.

An asterisk displays in front of the business model name on the tab to indicate that changes have been 
made to the model but not yet saved.
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CHAPTER 4 

Designing a Job
Talend Open Studio is the tool with capabilities that address all different sources and targets that 
you need for data integration processes and all of the related aspects.

Talend Open Studio helps you to develop job designs that allow you to put in place up and running 
dataflow management processes.

This chapter aims at programmers or IT managers who are ready to implement the technical aspects 
of a business model (designed or not in Talend Open Studio’s Business Modeler).



Designing a Job
Objectives
4.1 Objectives

A job design is the runable layer of a business model. It translates business needs into code, routines and 
programs, in other words it technically implements your data flow.

The job design is the graphical and functional view of a technical process.

From Talend Open Studio, you can: 

• put in place actions in your job design using a library of technical components.

• change the default setting of components or create new components or family of components to 
match your exact needs.

• set connections and relationships between components in order to define the sequence and the 
nature of actions 

• access code at any time to edit in Perl or document your job components.

• create and add items to the Repository for reuse and sharing purposes (in other projects or Jobs 
or with other users).

In order to be able to execute the Jobs you design in Talend Open Studio, you need to install a JVM Sun 
1.5 or later (IBM JVM is not supported). You can download it from 
http://java.sun.com/javase/downloads/index.jsp.

4.2 Opening or Creating a Job 

Open Talend Open Studio following the procedure as detailed in chapter Launching Talend Open 
Studio on page 6.

In Talend Open Studio Repository tree view, click the Job Designs node to expand the technical job 
tree.

You can create folders via the right-click menu to gather together families of Jobs. Right-click the Job 
Designs node, and choose Create folder. Give a name to this folder and click OK. 

If you have already created Jobs that you want to move in this new folder, simply drop them into the 
folder.

4.2.1 Opening a Job

Double-click the label of the Job you want to open.

The design workspace opens up on the selected job last view.
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You can open as many job designs as you need. They will all display in a tab system 
on your design workspace.

4.2.2 Creating a Job

Right-click the Job Designs node and select Create job in the drop-down list. The creation [New 
job] wizard helps you to define the main properties of the new Job.

Field Description

Name Enter a name for your new Job. A message comes up if you enter prohibited 
characters. 

Purpose Enter the Job purpose or any useful information regarding the Job use.
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An empty design workspace opens up showing only the name of the Job as a tab label.

You can create and then open as many job designs as you need. They will display in a 
tab system on your design workspace.

Talend Open Studio Graphical User Interface is made of the followings:

• design workspace,

• a Palette of components and connections specific for designing a Job,

• a Configuration tabs system which can be edited to change or set parameters related to a 
particular component or to the Job as a whole.

4.3 Getting started with a Job Design

Until a Job is created, the design workspace is unavailable and the Palette doesn’t display.

If you’re designing a Job for the first time, the design workspace opens on an empty area. If you’re 
opening an already existing Job, it opens on the last view it was saved on. For more information about 
Job opening and creation, see Opening or Creating a Job on page 66.

A job design is made of one or several Subjobs, which are themselves defined by one or, mostlikely, 
several components linked together. For more information about building a Job, see Connecting 
components together on page 74.

Then, as part of the job design process, each component requires to be configured individually, in order 
to function properly. For more information about component configuration, see Defining the component 
properties on page 82.

4.3.1 Showing, hiding and moving the Palette

The Palette contains all basic elements to create the most complex Jobs in the design workspace. 
These components are grouped in families and sub-families. 

By default, the Palette might be hidden on the right hand side of your design workspace.

If you want the Palette to show permanently, click the left arrow, at the right top corner of 
the design workspace, to make it visible at all times.

For specific component configuration, check out the Talend Open Studio Components 
Reference Guide.

Description Enter a description if need be for the created Job.

Author The Author field is read-only as it shows by default the current user login.

Version The Version is also read-only. You can manually increment the version using 
the M and m buttons. For more information, see Managing Job versions on 
page 73.

Status You can define the status of a Job in your preferences. By default none is 
defined. To define them, go to Window > Preferences > Talend > Status.

Field Description
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You can also move around the Palette outside the design workspace within Talend Open Studio’s 
main window. To enable the standalone Palette view, click the Window menu > Show View... > 
General > Palette.

4.3.2 Click & drop components from the Palette

To actually start building a Job, click a Component or a Note, on the Palette. Then click again to 
drop it on the design workspace and add it to your job design. 

If the Palette doesn’t show, see Showing, hiding and moving the Palette on page 68.

Each newly added component displays generally in a blue square that symbolizes it as an individual 
Subjob. 

Connect components together in a logical order using the connections offered, in order to build a full 
Job or Subjob. For more information about component connection types, see Connection types on 
page 74.

The Job or Subjob gets highlighted in one single blue rectangle. For more information about Job and 
Subjob background color, see Subjob colored highlight on page 79.

Multiple information or warnings may show next to the component. Browse over the component 
icon to display the information tooltip. This will display until you fully completed your job design 
and defined all basic (and sometimes advanced) component properties of the Component view.

 
You will be required to use the relevant code, i.e. Perl code in Perl jobs and java code in Java jobs.

Related topics:

• Connecting components together on page 74

• Warnings and errors on components on page 72

• Defining the component properties on page 82
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4.3.3 Drop components from the Metadata node

For recurrent use of files and DB connections in various Jobs, we recommend you to store the 
connection and schema metadata in the Repository tree view. For more information about the 
Metadata Manager wizards, see Defining Metadata items on page 92. 

Once the relevant metadata are stored in the Metadata node, you will be able to drag & drop 
elements directly onto the design workspace.

• In the Repository tree view, expand Metadata and the relevant folder(s) in succession.

• Drop the relevant connection/schema onto the design workspace.

A dialog box will prompt you to select the component you want to use among those offered.

• Select the component and click OK. The selected component displays on the design 
workspace.
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Or, according to the type of component (Input or Output) that you want to use, perform one of the 
following operations:

• Output: Press Ctrl on your keyboard while you drop the component onto the design 
workspace to directly include it in the active Job.

• Input: Press Alt on your keyboard while you drop the component onto the design workspace 
to directly include it in the active Job.

If you double-click the component, the Component view shows the selected connection details as 
well as the selected schema information.

If you select the connection without selecting a schema, then the properties will be 
filled with the first encountered schema.

4.3.4 Adding Notes to a Job design

In the Palette, click the Misc family and then drop the Note element to the design workspace to add 
a text comment to a particular component or to the whole Job.

You can change the note format. To do so, select the note you want to format and click the Basic 
setting tab of the Component view.

Select the Opacity check box to display the background color. By default, this box is selected when 
you drop a note on the design workspace. If you clear this box, the background becomes transparent.

You can select options from the Fonts and Colors list to change the font style, size, color, and so 
on as well as the background and border color of your note.

You can select the Adjust horizontal and Adjust vertical boxes to define the vertical and horizontal 
alignment of the text of your note.

The content of the Text field is the text displayed on your note.
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4.3.5 Changing panels position

All panels can be moved around according to your needs.

Click the border or on a tab, hold down the mouse button and drag the panel to the target destination. 
Release to change the panel position.

Click the cross to close one view. To get a view back on display, click Window > Show View > 
Talend, then click the name of the panel you want to add to your current view or see Shortcuts and 
aliases on page 138.

If the Palette doesn’t show or if you want to set it apart in a panel, go to Window > Show view...> 
General > Palette. The Palette opens in a separate view that you can move around wherever you 
like within Talend Open Studio’s main window.

4.3.6 Warnings and errors on components

When a component is not properly defined or if the link to the next component does not exist yet, a 
red checked circle or a warning sign is docked at the component icon.

Mouse over the component, to display the tooltip messages or warnings along with the label. This 
context-sensitive help informs you about any missing data or component status.
72 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Job
Getting started with a Job Design
4.3.7 Managing Job versions

When you create a Job in Talend Open Studio, par default its version is 0.1 where 0 stands for the 
major version and 1 for the minor version.

You can create many versions of the same Job. To do that:

• Close your Job if it is open on the design workspace, otherwise, its properties will be 
read-only and thus you can not modify them.

• In the Repository tree view, right-click your Job and select Edit properties in the 
drop-down list to open the [Edit properties] dialog box.

• Next to the Version field, click the M button to increment the major version and the m button 
to increment the minor version.

• Click Finish to validate the modification.

By default, when you open a Job, you open its last version. 
Any previous version of the Job is read-only and thus can not be modified

You can access a list of the different versions of a Job and perform certain operations. To do that:

• In the Repository tree view, select the Job you want to consult the versions of.

• Click the Job > Version in succession to display the version list of the selected Job.

• Right-click the job version you want to consult.

• Do one of the followings:

You can open and modify the last version of a Job from the Version view if you select 
Edit job from the drop-down list.

Select To...

Read job consult the Job in read-only mode.

Open Job Hierarchy consult the hierarchy of the Job.

Edit properties edit job properties. 
Note: The Job should not be open on the design 
workspace, otherwise it will be in read-only mode.

Run job execute the Job.
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4.4 Connecting components together

A Job or Subjob is defined by a group of components interconnected in a logical way. The Job itself can 
be built with several Subjobs carrying out various processings. 

The component forming a Subjob, as well as the Subjobs are connected to each using various type of 
connections.

Also, a Job (made of one or more subjobs) can be preceded by a Pre-Job and followed by a Post-Job, in 
order to ensure that some specific tasks (often not related to the actual data processing) are performed 
first or last in the process. For more information, see Prejob and postjob parts on page 81.

4.4.1 Connection types

There are various types of connections which define either the data to be processed, the data output, 
or the job logical sequence. 

On your design workspace, when dragging the link away from your source component towards 
the destination component, a graphical plug indicates if the destination component is valid or not. 
The black crossed circle only disappears once you reached a valid target component.

Only the connections authorized for the selected component are listed on the right-click contextual 
menu. 

The types of connections proposed are different 
for each component according to its nature and 
role within the Job, i.e. if the connection is 
meant to transfer data (from a defined schema) 
or if no data is handled.

The types of connections available depend also 
if data come from one or multiple input files and 
get transferred towards one or multiple outputs.

Right-click a component on the design workspace to display a pop-up menu that lists all available 
links for the selected component.

Row connection

The Row connection handles the actual data. The Row links can be main, lookup, reject or 
output according to the nature of the flow processed.

Main

The Main row is the most commonly used connection. It passes on data flows from one 
component to the other, iterating on each row and reading input data according to the 
component properties setting (schema).

Data transferred through main rows are characterized by a schema definition which 
describes the data structure in the input file.

You cannot connect two Input components together using a main Row 
connection. Only one incoming Row connection is possible per component. 
You will not be able to link twice the same target component using a main 

Row connection. The second row linking a component will be called Lookup.
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• Right-click the input component and select Row > Main on the connection list.

• Alternatively click the component to highlight it, then while you right-click, drag the 
cursor towards the destination component. This will automatically create a 
Row>Main type of connection. 

To be able to use multiple Row connections, see Multiple Input/Output on page 78.

Lookup

The Lookup row is a Row connecting a sub-flow component to a main flow component 
(which should be allowed to receive more than one incoming flow). This connection is used 
only in the case of multiple input flows.

A Lookup row can be changed into a main row at any time (and reversely, a main row can 
be changed to a lookup row). To do so, right-click the row to be changed, and on the pop-up 
menu, click Set this connection as Main.

Related topic: Multiple Input/Output on page 78.

Filter

The Filter link connect specifically a tFilterRow component to an output component. This 
row link gathers the data matching the filtering criteria. This particular component offers 
also a Reject link to fetch the non-matching data flow.
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Rejects

The Rejects link connects a processing component to an output component. This row link 
gathers the data that does NOT match the filter or are not valid for the expected output. This 
link allows you to track the data that could not be processed for any reason (wrong type, 
undefined null value...). 

Output

The Output row connects a tMap component to one or several output components. As the 
job output can be multiple, you get prompted to give a name for each output row created. 

The system also remembers deleted output link names (and properties if they 
were defined). This way, you do not have to fill in again property data in case 
you want to reuse them.

Related topic: Multiple Input/Output on page 78.

Uniques/Duplicates

The Uniques and Duplicates links connect a tUniqRow to output components.

The Uniques link gathers the rows that are found first in the incoming flow. This flow of 
unique data is directed to the relevant output component or else to another processing 
subjob.

The Duplicates link gathers the possible duplicates of the first encountered rows. This 
reject flow is directed to the relevant output component, for analysis for example.

Iterate connection

The Iterate connection can be used to loop on files contained in a directory, on rows contained 
in a file or on DB entries.

A component can be the target of only one Iterate link. The Iterate link is mainly to be 
connected to the Start component of a flow (in a subjob). 

Some components such as the tFileList component are meant to be connected through an iterate 
link with the next component.

Note that the Iterate link name is read-only unlike other types of connections.

You can set the Iterate link to run parallel iterations: 

• Simply select the Iterate link of your Subjob to display the related Basic settings view 
of the Components tab.

• Select the Enable parallel execution check box and set the number of executions to be 
carried out in parallel.

When executing your Job, the number of parallel iterations will be distributed onto the available 
processors. 
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Select the Statistics check box of the Run tab, to show the real time parallel executions on the 
design workspace.

Trigger connections

Trigger connections define the processing sequence, i.e. no data is handled through these 
connections.

The connection in use will create a dependency between Jobs or sub-jobs which therefore will 
be triggered one after the other according to the trigger nature.

Types of trigger connections

Trigger connections fall in two categories:

• subjob triggers: On Subjob Ok, On Subjob Error and Run if,

• component triggers: On Component Ok, On Component Error and Run if.

These connections are used to orchestrate the subjobs forming the Job or to easily 
troubleshoot and handle unexpected errors. 
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OnSubjobOK  (previously Then Run): This link is used to trigger the next subjob on the 
condition that the main subjob completed without error. This connection is to be used only 
from the start component of the Job. 

OnSubjobError: This link is used to trigger the next subjob in case the first (main) subjob 
do not complete correctly. This “on error” subjob helps flagging the bottleneck or handle the 
error if possible.

Related topic: Defining the Start component on page 89.

 OnComponentOK and OnComponentError are component triggers. They can be used 
with any source component on the subjob.

OnComponentOK will only trigger the target component once the execution of the source 
component is complete without error. Its main use could be to trigger a notification subjob 
for example.

OnComponentError will trigger the sub-job or component as soon as an error is 
encountered in the primary Job.

Run if triggers a subjob or component in case the condition defined is met. Click the If 
connection to display its Basic settings view where you can set the condition in Perl or in 
Java according to the generation language you selected. Pressing Ctrl+Space allows you to 
access all global and context variables.

Link connection

The Link connection can only be used with ELT components. The Links transfer table schema 
information to the ELT mapper component in order to be used in specific DB query statements.

Related topics: ELT components in the Talend Open Studio Components Reference Guide.

The Link connection therefore does not handle actual data but only the metadata regarding the 
table to be queried on.

When right-clicking on the ELT component to be connected, select Link > New Output. 

 
Be aware that the name you provide to the link MUST reflects the actual table name.

In fact, the link name will be used in the SQL statement generated through the ETL Mapper, 
therefore the same name should never be used twice.

4.4.2 Multiple Input/Output

Some components help handle data through multiple inputs and/or multiple outputs. These are often 
processing-type components such as the tMap.
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If this requires a join or some transformation in one flow, you want to use the tMap component, 
which is dedicated to this use.

For further information regarding data mapping , see Mapping data flows on page 93.

For properties regarding the tMap component as well as use case scenarios, see tMap in the Talend 
Open Studio Components Reference Guide.

4.4.3 Error icons on Jobs

When the component settings contain one or several errors that can prevent the job code to compile 
properly, an icon will automatically show next to the job name in the Repository tree view. 

The error icon displays as well on the tab next to the job name when you open the Job on the design 
workspace.

The compilation or code generation does only take place when carrying out one of the following 
operations:

• opening a Job,

• clicking on the Code view tab,

• executing a Job (clicking on Run Job),

• saving the Job.

Hence, the red error icon will only show then.

When you execute the Job, a warning dialog box opens to list the source and description of any error 
in the current Job.

Click Cancel to stop your job execution or click Continue to continue it.

4.4.4 Subjob colored highlight

A subjob is graphically defined by a blue square gathering all connected components that belong to 
this subjob. Each individual component can be considered as a subjob when they are not yet 
connected to one another.
Creative Commons License Talend Open Studio 79

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Job
Connecting components together
This blue highlight helps you easily distinguish one subjob from another.

A Job can be made of one single subjob. An orange square shows the prejob and 
postjob parts which are different types of subjobs. 
For more information about prejob and postjob, see Prejob and postjob parts on page 

81.

Formatting subjobs

You can modify the subjob color and its title color. To do so, select your subjob and click the 
Component view.

In the Basic setting view, select the Show subjob title check box if you want to add a title to 
your subjob, then fill in a title.

To modify the title color and the subjob color:

• In the Basic settings view, click the Title color/Subjob color button to display the 
[Colors] dialog box.

• Set your colors as desired. By default, the title color is blue and the subjob color is 
transparent blue.

Collapsing the subjobs

If your Job is made of numerous subjobs, you can collapse them to improve the readability of 
the whole Job. The minus (-) and plus (+) signs on the top right-hand corner of the subjob allow 
you to collapse and restore the complete subjob.
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click the minus sign (-) to collapse the subjob (left screenshot). When reduced, only the first 
component of the subjob is displayed.

Click the plus sign (+) to restore your subjob (right screenshot).

Removing the subjob background color

If you do not want your subjobs to be highlighted, you can remove the background color on all 
or specific subjobs.

To remove the background color of all your subjobs, click the Toggle Subjobs icon on the 
toolbar of Talend Open Studio.

To remove the background color of a specific subjob, right-click the subjob and select the Hide 
subjob option on the pop-up menu.

4.4.5 Prejob and postjob parts

The prejob and postjob parts display as components on the design workspace, and are thus available 
in the Palette of components. To use these prejob and postjob components, simply drop them to the 
design workspace as you would do with any other components.An orange square shows the pre and 
post-job parts which are different types of subjobs. 

However note that their use slightly differs from typical components, in the way that these two 
components do not actually process data nor flows but are meant to help you make your job design 
clearer.

As prejob and postjob are not meant to take part in any data processing, they can not 
be part of multithread execution. The tasks included in the prejob and subjob are done 
once for all following subjobs, whether the subjobs are executed in sequence or in 

parallel.

Connect to these Pre and Postjobs, all the components that perform organizing tasks that are not 
directly related to the data processing or the main subjob but help orchestrating the processing that 
will follow.
Creative Commons License Talend Open Studio 81

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Job
Defining the component properties
Tasks that require a prejob component to be used include for example:

• loading context information required for the subjob execution,

• opening a database connection,

• making sure that a file exists.

And many more tasks that are collateral to your Job and might be damaging the overall readability 
of your Job should they be part of the Job itself. 

Tasks that require a postjob component to be used include, for example:

• clearing a folder or deleting a file,

• any tasks to be carried out even though the preceding subjob(s) failed.

4.5 Defining the component properties

The properties information for each component forming a Job or a sub-job allows to set the actual 
technical implementation of the active Job.

Each component is defined by basic and advanced properties shown respectively on the Basic Settings 
tab and the Advanced Settings tab of the Component view. The Component view gathers also other 
collateral information related to the component in use, including View and Documentation tabs. 

For detailed configuration for each component displaying in the Palette, check out the Talend Open 
Studio Components Reference Guide. 
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4.5.1 Basic Settings tab

The Basic Settings tab is part of the Component view, which is located on the lower part of the 
designing editor of Talend Open Studio.

Each component has specific basic settings according to its function requirements within the Job. 
For a detailed description of each component properties and use, see the Talend Open Studio 
Components Reference Guide.

Some components require code to be input or functions to be set. Where relevant, 
make sure you use the correct code, i.e. Perl code in perl properties and Java code in 
Java properties.

For File and Database components you can centralize properties in metadata files located in the 
Metadata directory of the Repository tree view. This means that on the Basic Settings tab you can 
set properties on the spot, using the Built-In Property type or use the properties you stored in the 
Metadata Manager using the Repository Property type. The latter option helps you save time 
when the configuration is often.

Select Repository as Property type and choose the metadata file holding the relevant information. 
Related topic: Defining Metadata items on page 92.

Or you can drop the Metadata item from the Repository tree view directly to the component 
already dropped on the design workspace, for its properties to be filled in automatically.

For all components that handle a data flow (most components), you can define a Talend schema in 
order to describe and possibly select the data to be processed. Like the Properties data, this schema 
is either Built-in or stored remotely in the repository in a metadata file that you created. A detailed 
description of the Schema setting is provided in the next sections.

Setting a built-in schema

A schema created as Built-in is meant for a single use in a Job, hence cannot be reused in another 
Job or station.

Select Built-in in the list, and click Edit Schema to create your built-in schema by adding 
columns and describing their content, according to the input file definition.
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In all output properties, you also have to define the schema of the output. To retrieve the schema 
defined in the input schema, click Sync columns button.

In Java, some extra information is required. For more information about Date 
pattern for example, check out: 
http://java.sun.com/j2se/1.5.0/docs/api/index.html.

Setting a Repository schema

You can avoid redundancy of schema metadata and hold them together in a central place, by 
creating metadata files and store them in the Repository > Metadata. 

To recall a metadata file into your current Job, select the Schema type Repository and select the 
relevant metadata file in the list. Or, drop the metadata item from the Repository directly to the 
component already dropped on the design workspace. Then click Edit Schema to check the data 
are appropriate.

You are free to edit a repository schema used for a Job. However, note that the schema hence 
becomes built-in to the current Job. 

You cannot change the remotely stored schema from this window.
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Related topics: Defining Metadata items on page 92

Setting a field dynamically (Ctrl+Space bar)

On any field of your Job/component Properties view, you can use Ctrl+Space bar to access 
the global and context variable list and set the relevant field value dynamically.

• Place the cursor on any field of the Component view.

• Press Ctrl+Space bar to access the proposal list. 

• Select on the list the relevant parameters you need. Appended to the Variable list, a 
information panel provides details about the selected parameter.

This can be any parameter including: error messages, number of lines processed, or else... The 
list varies according to the component in selection or the context you’re working in.

Related topic: Defining Contexts and variables on page 116

4.5.2 Advanced settings tab

Some components, especially File and Database components, provides numerous advanced use 
possibilities.

The content of the Advanced settings tab changes according to the selected component. 
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Generally you will find on this tab the parameters that are not required for a basic or usual use of 
the component but may be required for a use out of the standard scope.

Measuring data flows

You can also find in the Advanced settings view the option tStatCatcher Statistics that allows 
you, if selected, to display logs and statistics about the current Job without using dedicated 
components. For more information regarding the stats & log features, see Automating statistics 
& logs use on page 136.

4.5.3 Dynamic settings tab

All components Basic Settings and Advanced Settings tabs display various check boxes and 
drop-down lists for component-specific parameters. Usually, available values for these types of 
parameters is either true or false and can only be edited at designing time.

The Dynamic settings tab, on the Component view, allows you to customize these parameter into 
code or variable.

This feature allows you, for example, to define these parameters as variables and thus let them 
become context-dependent, whereas they are not meant to be by default.

Another benefit of this feature is that you can now change the context setting at execution time. This 
makes full sense when you intend to export your job script in order to deploy it onto a job execution 
server for example.
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To customize these types of parameters, as context variables for example, follow the following 
steps: 

• Select the relevant component basic settings or advanced settings view that contains the 
parameter you want to define as a variable.

• Click the Dynamic settings tab.

• Click the plus button to display a new parameter line in the table.

• Click the Name of the parameter displaying to show the list of available parameters. For 
example: Print operations

• Then click in the facing Code column cell and set the code to be used. For example: 
context.verbose if you create the corresponding context variable, called verbose.  

As code, you can input a context variable or a piece of code (in Java or Perl) according 
to your generation language.

The corresponding lists or check boxes thus become unavailable and are highlighted in yellow in the 
Basic or Advanced Settings tab.

If you want to set a parameter as context variable, make sure you create the 
corresponding variable in the Context view.  
For more information regarding the context variable definition, see Defining variables 

on the Contexts view on page 117.

You could also use a global variable or pieces of java or perl code, to store the values to be used for 
each parameter.  
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For example, use some global variable available through the Ctrl+Space bar keys, and adapt it to 
your context.

4.5.4 View tab

The View tab of the Component view allows you to change the default display format of 
components on the design workspace.

You can graphically highlight both Label and Hint text with HTML formatting tags:

• Bold: <b> YourLabelOrHint </b>

• Italic: <i> YourLabelOrHint </i>

• Return carriage: YourLabelOrHint <br> ContdOnNextLine

• Color: <Font color= ‘#RGBcolor’> YourLabelOrHint </Font>

To change your preferences of this View panel, click Window>Preferences>Talend>Designer. 

4.5.5 Documentation tab

Feel free to add any useful comment or chunk of text or documentation to your component. 

Field Description

Label format Free text label showing on the design workspace. Variables can be set to 
retrieve and display values from other fields. The field tooltip usually shows 
the corresponding variable where the field value is stored. 

Hint format Hidden tooltip, showing only when you mouse over the component.

Connection format Indicates the type of connection accepted by the component.
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The content of this Comment field will be formatted using Pod markup and will be integrated in the 
generated code. You can view your comment in the Code panel.

You can show the Documentation in your hint tooltip using the associated variable (_COMMENT_)

For advanced use of Documentations, you can use the Documentation view in order to store and 
reuse any type of documentation.

4.6 Defining the Start component

The Start component is the trigger of a Job. There can be several Start components per job design if there 
are several flows running in parallel. But for one flow and its connected subflows, only one component 
can be the Start component.

drop a component to the design workspace, all possible start components take a distinctive bright green 
background color. Notice that most of the components, can be Start components. 

Only components which do not make sense to trigger a flow, will not be proposed as Start components, 
such as the tMap component for example. 
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To distinguish which component is to be the Start component of your Job, identify the main flow and 
the secondary flows of your Job 

• The main flow should be the one connecting a component to the next component using a Row 
type link. The Start component is then automatically set on the first component of the main flow 
(icon with green background).

• The secondary flows are also connected using a Row-type link which is then called Lookup row 
on the design workspace to distinguish it from the main flow. This Lookup flow is used to enrich 
the main flow with more data.

Be aware that you can change the Start component hence the main flow by changing a main Row into 
a Lookup Row, simply through a right-click the row to be changed. 

Related topics:

• Connecting components together on page 74

• Activating/Disabling a Job or sub-job on page 132

4.7 Using SQL Templates

Talend Open Studio allows you to benefit from using some system SQL templates since many query 
structures are standardized with common approaches.

Talend Open Studio lists system SQL templates under the SQL Templates node in the Repository tree 
view. There, you can find Generic, MySQL, Oracle, and Teradata standardized SQL templates.
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 In each of the above categories, you can create your own user-defined SQL templates using the SQL 
templates wizard.

To create a user-defined SQL template:

• In the Repository tree view, expand SQL Templates and the category you want to create the 
SQL template in.

• Right-click UserDefined and select Create SQL Template to open the [SQL Templates] 
wizard.
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• Define your new SQL template in the corresponding fields and click Finish to close the wizard. 
The name of the newly created template shows under UserDefined in the Repository tree view. 
An SQL template editor opens on the design workspace where you can enter the code of the 
newly created template.

For more information about how to create a user-defined SQL template and use it in a job context, see 
Scenario: Iterating on DB tables and deleting their content using a user-defined SQL template in the 
Talend Open Studio Components Reference Guide.

4.8 Defining Metadata items

Talend Open Studio is a metadata-driven solution, and can therefore help you ensure the whole Job 
consistency and quality, through a centralized metadata manager in the Repository. 

The Metadata node in the Repository tree view gathers various wizards to help you set up connections 
to the files, databases, and/or systems you usually connect to.

This way you can store centrally the connection details you need to connect to your usual utilities and 
you can easily reuse them over and over in all your job designs without re-entering them every time.

From the metadata wizards, you can collect and centralize connection details to the following utilities:

• DB Connection: connection details and table data description (schema) of any type of database 
and JDBC connections
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• File Delimited/Positional/Regex/XML/Excel/Ldif: file access details and description of data 
from the types of file listed.

• LDAP: access details and data description of an LDAP directory.

• Salesforce: access details and data description of a Salesforce table.

• WSDL: access details and data description of a webservice.

• Generic schema: access details and data description of any sort of sources.

For more information about these Metadata creation procedures, see Managing Metadata on page 141. 

4.9 Mapping data flows

The most common way to handle multiple input and output flows including transformations and data 
re-routing is to use the tMap component. The following section gives details about the usage principles 
of this component, for further information or scenario and use cases, see tMap in the Talend Open 
Studio Components Reference Guide.

4.9.1 tMap operation overview

tMap allows the following types of operations:

• data multiplexing and demultiplexing,

• data transformation on any type of fields,

• fields concatenation and interchange,

• field filtering using constraints,

• data rejecting.

As all these operations of transformation and/or routing are carried out by tMap, this component 
cannot be a Start or End component in the job design.
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tMap uses incoming connections to pre-fill input schemas with data in the Map Editor. Therefore, 
you cannot create new input schemas directly in the Map Editor. Instead, you need to implement 
as many Row connections incoming to tMap component as required, in order to create as many 
input schemas as needed.

The same way, create as many output row connections as required. However, you can fill in the 
output with content directly in the Map Editor through a convenient graphical editor. 

Note that there can be only one Main incoming rows. All other incoming rows are of Lookup type. 
Related topic: Row connection on page 74.

Lookup rows are incoming connections from secondary (or reference) flows of data. These 
reference data might depend directly or indirectly on the primary flow. This dependency relationship 
is translated with an graphical mapping and the creation of an expression key.  

Although the Map Editor requires the connections to be implemented in order to define Input and 
Output flows, you also need to create the actual mapping in order for the Preview to be available in 
the Component panel of the design workspace.

Double-click the tMap icon or click the Map Editor three-dot button to open the editor in a new 
window.

4.9.2 tMap interface

tMap is an advanced component which requires more detailed explanation than other components. 
Indeed, the Map Editor is an “all-in-one” tool allowing you to define all parameters needed to map, 
transform and route your data flows via a convenient graphical interface.

For all tables and the [Map Editor] window, you can minimize and restore the window using the 
window icon.
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The Map Editor is made of several panels: 

• The Input panel is the top left panel on the window. It offers a graphical representation of 
all (main and lookup) incoming data flows. The data are gathered in various columns of input 
tables. Note that the table name reflects the main or lookup row from the job design on the 
design workspace.

• The Variable panel is the central panel on the [Map Editor] window. It allows the 
centralization of redundant information through the mapping to variable and allows you to 
carry out transformations.

• The Output panel is the top right panel on the window. It allows mapping data and fields 
from Input tables and Variables to the appropriate Output rows.

• Both bottom panels are the Input and Output schemas description. The Schema editor tab 
offers a schema view of all columns of input and output tables in selection in their respective 
panel. 
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• Expression editor is the edition tool for all expression keys of Input/Output data, variable 
expressions or filtering conditions.

The name of Input/Output tables in the mapping editor reflects the name of the incoming and 
outgoing flows (row connections).

4.9.3 Setting the input flow in the Map Editor 

The order of the Input tables is essential. The top table reflects the Main flow connection, and for 
this reason, is given priority for reading and processing through the tMap component.

For this priority reason, you are not allowed to move up or down the Main flow table. This ensures 
that no Join can be lost.

Although you can use the up and down arrows to 
interchange Lookup tables order, be aware that 
the Joins between two lookup tables may then be 
lost.

Related topic: Explicit Join on page 97.

Filling in Input tables with a schema

To fill in input tables, you need to define first the 
schemas of all input components connected to 
the tMap component on your design workspace. 

Main and Lookup table content

The order of the Input tables is essential.

The Main Row connection determines the Main 
flow table content. This input flow is reflected in 
the first table of the Map Editor’s Input panel. 

The Lookup connections’ content fills in all 
other (secondary or subordinate) tables which 
displays below the Main flow table. If you have 
not define the schema of an input component yet, 
the input table displays as empty in the Input 
area.

The key is also retrieved from the schema 
defined in the Input component. This Key 
corresponds to the key defined in the input 
schema where relevant. It has to be distinguished 
from the hash key that is internally used in the 
Map Editor, which displays in a different color. 

Variables

You can use global or context variables or reuse the variable defined in the Variables area. 
Press Ctrl+Space bar to access the list of variables. This list gathers together global, 
context and mapping variables. 
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The list of variables changes according to the context and grows along new variable 
creation. Only valid mappable variables in the context show on the list.

Docked at the Variable list, a metadata tip box display to provide information about the 
selected column.

Related topic: Mapping variables on page 100

Explicit Join

In fact, Joins let you select data from a table depending upon the data from another table. In the 
Map Editor context, the data of a Main table and of a Lookup table can be bound together on 
expression keys. In this case, the order of table does fully make sense.

Simply drop column names from one table to a subordinate one, to create a Join relationship 
between the two tables. This way, you can retrieve and process data from multiple inputs.

The join displays graphically as a violet link and creates automatically a key that will be used 
as a hash key to speed up the match search. 

You can create direct joins between the main table and lookup tables. But you can also create 
indirect joins from the main table to a lookup table, via another lookup table. This requires a 
direct join between one of the Lookup table to the Main one. 

You cannot create a Join from a subordinate table towards a superior table in the 
Input area.

The Expression key field which is filled in with the dragged and dropped data is editable in the 
input schema or in the Schema editor panel, whereas the column name can only be changed 
from the Schema editor panel.

You can either insert the dragged data into a new entry or replace the existing entries or else 
concatenate all selected data into one cell.
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For further information about possible types of drag & drops, see Mapping the Output setting 
on page 102.

If you have a big number of input tables, you can use the minimize/maximize icon 
to reduce or restore the table size in the Input area. The Join binding two tables 
remain visible even though the table is minimized.

Creating a join automatically assigns a hash key onto the joined field name. The key symbol 
displays in violet on the input table itself and is removed when the join between the two tables 
is removed.

Related topics: 

• Schema editor on page 105

• Inner join on page 99

Along with the explicit Join you can select whether you want to filter down to a unique match 
of if you allow several matches to be taken into account. In this last case, you can choose to only 
consider the first or the last match or all of them.

Unique Match

This is the default selection when you implement an explicit Join. This means that zero or 
one match from the Lookup will be taken into account and passed on to the output.

If more matches are available, a warning notification displays.

First Match

This selection implies that several matches can be expected in the lookup. The First Match 
selection means that in the lookup only the first encountered match will be taken into 
account and passed onto the main output flow.

The other matches will then be ignored.
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All Matches

This selection implies that several matches can be expected in the lookup flow. In this case, 
all matches are taken into account and passed on to the main output flow.

Inner join

The Inner join is a particular type of Join that distinguishes itself by the way the rejection is 
performed. 

This option avoids that null values are passed on to the main output flow. It allows also to pass 
on the rejected data to a specific table called Inner Join Reject table.

If the data searched cannot be retrieved through the explicit join or the filter (inner) join, in other 
words, the Inner Join cannot be established for any reason, then the requested data will be 
rejected to the Output table defined as Inner Join Reject table if any.

Basically select the Inner Join check box located at the top a lookup table, to define this table 
as Inner Join table.

On the Output area, click the Inner Join Reject button to define the Inner Join Reject output.  

 
An Inner Join table should always be coupled to an Inner Join Reject table.

You can also use the filter button to decrease the number of rows to be searched and improve 
the performance (in java).

Related topics: 
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• Inner Join Rejection on page 104

• Filtering an input flow (java) on page 100

All rows (java)

When you select the All rows check box, the Inner Join feature gets automatically greyed out. 
This All rows option means that all the rows are loaded from the Lookup flow and searched 
against the Main flow.

The output corresponds to the Cartesian product of both table (or more tables if need be).

Filtering an input flow (java)

Click the Filter button next to the Inner join button to add a Filter area. 

In the Filter area, type in the condition to be applied. This allows to reduce the number of rows 
parsed against the main flow, enhancing the performance on long and heterogeneous flows.

You can use the Autocompletion tool via the Ctrl+Space bar keystrokes in order to reuse 
schema columns in the condition statement.

 
This feature is only available in Java therefore the filter condition needs to be written in Java.

Removing input entries from table

To remove input entries, click the red cross sign on the Schema Editor of the selected table. Press 
Ctrl or Shift and click fields for multiple selection to be removed.

If you remove Input entries from the Map Editor schema, this removal also 
occurs in your component schema definition.

4.9.4 Mapping variables  

The Variable table regroups all mapping variables which are used numerous times in various places. 

You can also use the Expression field of the Var table to carry out any transformation you want to, 
using Perl code or Java Code.

Variables help you save processing time and avoid you to retype many times the same data.
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There are various possibilities to create variables:

• Type in freely your variables in Perl. Enter the strings between quotes or concatenate 
functions using a dot as coded in Perl.

• Add new lines using the plus sign and remove lines using the red cross sign. And press 
Ctrl+Space to retrieve existing global and context variables.

• Drop one or more Input entries to the Var table.

Select an entry on the Input area or press Shift key to select multiple entries of one Input table. 

Press Ctrl to select either non-appended entries in the same input table or entries from various 
tables. When selecting entries in the second table, notice that the first selection displays in grey. Hold 
the Ctrl key down to drag all entries together. A tooltip shows you how many entries are in selection.

Then various types of drag-and-drops are possible depending on the action you want to carry out.

Accessing global or context variables

Press Ctrl+Space to access the global and context variable list. 

To... you need to...

Insert all selected entries as separated 
variables.

Simply drag & drop to the Var table. Arrows show you 
where the new Var entry can be inserted. Each Input is 
inserted in a separate cell.

Concatenate all selected input entries 
together with an existing Var entry.

Drag & drop onto the Var entry which gets 
highlighted. All entries gets concatenated into one 
cell. Add the required operators using Perl/Java 
operations signs. The dot concatenates string 
variables.

Overwrite a Var entry with selected 
concatenated Input entries.

Drag & drop onto the relevant Var entry which gets 
highlighted then press Ctrl and release. All selected 
entries are concatenated and overwrite the highlighted 
Var.

Concatenate selected input entries 
with highlighted Var entries and 
create new Var lines if needed

Drag & drop onto an existing Var then press Shift 
when browsing over the chosen Var entries. First 
entries get concatenated with the highlighted Var 
entries. And if necessary new lines get created to hold 
remaining entries.
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Appended to the Variable list, a metadata list provides information about the selected column.

Removing variables

To remove a selected Var entry, click the red cross sign. This removes the whole line as well as 
the link. 

Press Ctrl or Shift and click fields for multiple selection then click the red cross sign.

4.9.5 Mapping the Output setting 

On the design workspace, the creation of a Row connection from the tMap component to the output 
components adds Output schema tables in the [Map Editor] window.

You can also add an Output schema in your Map Editor, using the plus sign from the tool bar of 
the Output area.

Unlike the Input area, the order of output schema tables does not make such a difference, as there 
is no subordination relationship between outputs (of Join type).

Once all connections, hence output schema tables, are created, you can select and organize the 
output data via drag & drops.

You can drop one or several entries from the Input area straight to the relevant output table.

Press Ctrl or Shift, and click entries to carry out multiple selection.

Or you can drag expressions from the Var area and drop them to fill in the output schemas with the 
appropriate reusable data.

Note that if you make any change to the Input column in the Schema Editor, a dialog prompts you 
to decide to propagate the changes throughout all Input/Variable/Output table entries, where 
concerned. 

You can add filters and rejection to customize your outputs.

Building complex expressions

If you have complex expressions to build, or advanced changes to be carried out on the output 
flow, then the Expression Builder interface can help in this task.

click the Expression field of your input or output table to display the three-dot button. Then 
click this three-dot button to open the Expression Builder.

Action Result

Drag & Drop onto existing 
expressions.

Concatenates the selected expression with the 
existing expressions.

Drag & Drop to insertion line. Inserts one or several new entries at start or end of 
table or between two existing lines.

Drag & Drop + Ctrl. Replaces highlighted expression with selected 
expression.

Drag & Drop + Shift. Adds to all highlighted expressions the selected fields. 
Inserts new lines if needed.

Drag & Drop + Ctrl + Shift. Replaces all highlighted expressions with selected 
fields. Inserts new lines if needed.
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For more information regarding the Expression Builder, see Writing code using the Expression 
Builder on page 108.

Filters

Filters allow you to make a selection among the input fields, and send only the selected fields 
to various outputs. 

Click the plus button at the top of the table to add a filter line.

You can enter freely your filter statements using Perl/Java operators and functions. 

Drop expressions from the Input area or from the Var area to the Filter row entry of the relevant 
Output table.

An orange link is then created. Add the required Perl/Java operator to finalize your filter 
formula. 

You can create various filters on different lines. The AND operator is the logical conjunction of 
all stated filters.  

Rejections

Reject options define the nature of an output table.

It groups data which do not satisfy one or more filters defined in the standard output tables. Note 
that as standard output tables, are meant all non-reject tables.

This way, data rejected from other output tables, are gathered in one or more dedicated tables, 
allowing you to spot any error or unpredicted case. 

The Reject principle concatenates all non Reject tables filters and defines them as an ELSE 
statement.

Create a dedicated table and click the Output reject button to define it as Else part of the regular 
tables.

You can define several Reject tables, to offer multiple refined outputs. To differentiate various 
Reject outputs, add filter lines, by clicking on the plus arrow button. 

Once a table is defined as Reject, the verification process will be first enforced on regular tables 
before taking in consideration possible constraints of the Reject tables.
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Note that data are not exclusively processed to one output. Although a data satisfied one 
constraint, hence is routed to the corresponding output, this data still gets checked against the 
other constraints and can be routed to other outputs.

Inner Join Rejection

The Inner Join is a Lookup Join. The Inner Join Reject table is a particular type of Rejection 
output. It gathers rejected data from the main row table after an Inner Join could not be 
established. 

To define an Output flow as container for rejected Inner Join data, create a new output 
component on your Job that you connect to the Map Editor. Then in the Map Editor, click the 
Inner Join Reject button to define this particular Output table as Inner Join Reject table.

Removing Output entries

To remove Output entries, click the cross sign on the Schema Editor of the selected table.

4.9.6 Expression editor

All expressions (Input, Var or Output) and constraint statements can be viewed and edited from the 
Expression editor. This editor provides visual comfort to write any functions or transformation in a 
handy dedicated window. 

Select the expression to be edited. Click Expression editor. 

Enter the Perl code or Java code according to your needs. The corresponding table expression is 
synchronized.

Refer to the relevant Perl or Java documentation for more information regarding 
functions and operations.
104 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Job
Mapping data flows
The Expression Builder can help you address your complex expression needs. For more 
informationWriting code using the Expression Builder on page 108.

4.9.7 Schema editor  

The Schema Editor details all fields of the selected table.

Use the tool bar below the schema table, to add, move or remove columns from the schema. 

You can also load a schema from the Repository or export it into a file.

 Input metadata and output metadata are independent from each other. You can, for 
instance, change the label of a column on the output side without the column label of 
the input schema being changed.

However, any change made to the metadata are immediately reflected in the corresponding schema 
on the tMap relevant (Input or Output) area, but also on the schema defined for the component itself 
on the design workspace.

A Red colored background shows that an invalid character has been entered. Most special characters 
are prohibited in order for the Job to be able to interpret and use the text entered in the code. 
Authorized characters include lower-case, upper-case, figures except as start character.

Browse the mouse over the red field, a tooltip displays the error message.

Metadata Description

Column Column name as defined on the Map Editor schemas and on 
the Input or Output component schemas.

Key The Key shows if the expression key data should be used to 
retrieve data through the Join link. If unchecked, the Join 
relation is disabled.

Type Type of data. String or Integer. 

This column should always be defined in a Java 
version

Length -1 shows that no length value has been defined in the schema.

Precision precise the length value if any is defined.

Nullable Clear this check box if the field value should not be null.

Default Shows any default value that may be defined for this field.

Comment Free text field. Enter any useful comment.
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4.9.8 Solving memory limitation issues in tMap use

When handling large data sources, including for example, numerous columns, large number of lines 
or of column types, your system might encounter memory shortage issues that prevent your Job, to 
complete properly, in particular when using a tMap component for your transformation.

A feature has been added (in Java only for the time being) to the tMap component, in order to reduce 
the memory in use for lookup loading. In fact, rather than storing the temporary data in the system 
memory and thus possibly reaching the memory limitation, the Store on Disk option allows you to 
choose to store the temporary data onto a temp directory of your disk instead. 

This feature comes as an option to be selected on the Lookup table of the input data in the tMap 
editor. 

To enable this option, follow the following steps:

• Double-click the tMap component in your Job to launch the tMap editor

• On the left panel, corresponding to the Input and Lookup sources, click the Lookup table 
describing the temporary data you want to be loaded onto the disk rather than on the memory. 

• Press the button Store temp data on disk to enable the option 

• Click OK to validate the change in the tMap and come back to the design workspace.

For this option to be fully activated, you also need to set the directory on the disk, where the data 
will be stored.
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• Click the Component tab to show the tMap component Basic settings view.

• On the Store on disk area, fill out the Temp data directory path field with the full path to 
the directory where the temporary data should be stored.

• You can use a context variable through the Ctrl+Space bar if you set the variable in a 
Context group in the Repository. For more information about contexts, see Defining 
Contexts and variables on page 116.

At the end of the subjob, the temporary files are cleared.

This way, you limit the use of allocated memory per reference data to be written onto temporary files 
stored on the disk. 

As writing the main flow onto the disk requires the data to be sorted, note that the order 
of the output rows cannot be guaranteed.

On the Advanced settings view, you can also set a buffer size if need be. Simply fill out the field 
Max. buffer size (in Nr of lines) in order for the data stored on the disk to be splitted into as many 
files as needed.

4.9.9 Handling lookups

In order to adapt to the multiple processing types as well as to address performance issues, different 
types of lookup loading are available in the tMap component. 

In the lookup area of the Map Editor, click on the small down arrow to explore the list of the loading 
types available:

• Load once: Default setting. Select this option to load the entire lookup flow before 
processing the main flow. This is the preferred option if you have a great number of data from 
your main flow that needs to be requested in your lookup, or if your reference (or lookup) 
data comes from a file that can be easily loaded.
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• Reload at each row: At each row, the lookup gets loaded again. This is mainly interesting 
in Jobs where the lookup volume is large, while the main flow is pretty small. Note that this 
option allows you to use dynamic variable settings such as where clause, to change/update 
the lookup flow on the fly as it gets loaded, before the main flow join is processed. This 
option could be considered as the counter-part of the Store on disk option that is available 
for file lookups.

• Reload at each row (cache): Expressions (in the Lookup table) are assessed and looked up 
in the cache first. The results of joins that have already been solved, are stored in the cache, 
in order to avoid loading the same results twice. This option optimizes the processing time 
and helps improve processing performance of the tMap component. 

Note that for the time being, you cannot use Reload at each row (cache) and Store 
on disk at the same time.

For use cases using these options, see the tMap section of the Talend Open Studio 
Components Reference Guide.

When your lookup is a database table, the best practise is to open the connection to the 
database in the beginning of your job design in order to optimize performance. For a 
use case using this option, see Scenario 6: Advanced mapping with lookup reload at 

each row (java) in Talend Open Studio Components Reference Guide.

4.10 Writing code using the Expression Builder

Some jobs require pieces of code to be written in order to provide components with parameters. In the 
Component view of some components, an Expression Builder interface can help you build these 
pieces of code (in Java or Perl generation language).

The following example shows the use of the Expression Builder in a tMap component.

Two input flows are connected to the tMap component. 

• From the DB input, comes a list of names made of a first name and a last name separated by a 
space char. 

• From the File input, comes a list of US states, in lower case.

In the tMap, use the expression builder to: First, replace the blank char separating the first and last 
names with an underscore char, and second, change the states from lower case to upper case. 

• In the tMap, set the relevant inner join to set the reference mapping. For more information 
regarding the use of the tMap, see Mapping data flows on page 93.
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• From the main (row1) input, drop the Names column to the output area, and the State column 
from the lookup (row2) input towards the same output area.

• Then click the first Expression field (row1.Name) to display the three-dot button.

The [Expression Builder] dialog box opens up.

• In the Category area, select the relevant action you want to perform. In this example, select 
StringHandling and select the EREPLACE function. 

• In the Expression area, paste row1.Name in place of the text expression, in order to get: 
StringHandling.EREPLACE(row1.Name," ","_"). This expression will replace the 
separating space char with an underscore char in the char string given.

•  Now check that the output is correct, by typing in the relevant Value field of the Test area, a 
dummy value, e.g:Tom Jones. 

• Then click Test! and check that the correct change is carried out, e.g: Tom_Jones

• Click OK to validate. 

• Carry out the same operation for the second column (State). 

• In the tMap output, select the row2.State Expression and click the three-dot button to open the 
Expression builder again.
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• This time, the StringHandling function to be used is UPCASE. The complete expression 
says: StringHandling.UPCASE(row2.State).

• Once again, check that the expression syntax is correct using a dummy Value in the Test area, 
e.g.: indiana.

• The Test! result should display INDIANA for this example.

• Click OK to validate.

Both expressions now display on the tMap Expression field.

These changes will be carried out along the flow processing. The output of this example is as shown 
below. 
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4.11 Sharing a database connection

If you have various Jobs using the same database connection, you can now factorize the connection by 
using the Use or Register a shared connection option. 

This option box has been added to all Connection components in order to reduce the number of 
connection opening and closing.

Assuming that you have two related Jobs (a parent job and a child job) that both need to connect to your 
remote MySQL database, then perform the operations below:

• Drag and drop a tMySQLConnection (assuming that you work with a MySQL database)

• Connect it to the first component of your parent Job
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• On the Connection Component view, tick the box Use or Register a shared connection.

• Give a name to the connection you want to share, in the Shared DB Connection Name field.

• You are now able to re-use the connection in your Child Job (and any other Job that requires a 
connection to the same database).

• Simply follow the same steps again and make sure you use the same name in the Shared DB 
Connection Name field.

For more information about how to use the Connection components, see Talend Open Studio 
Components Reference Guide. 

4.12 Creating queries using SQLBuilder

SQLBuilder helps you build your SQL queries and monitor the changes between DB tables and metadata 
tables. This editor is available in all DBInput and DBSQLRow components (specific or generic).

You can build a query using SQLbuilder whether your database table schema is stored in the Repository 
or built-in directly in the job component.

Fill in the DB connection details and select the appropriate repository entry if you defined it. 

Remove the default query statement in the Query field of the Component panel. Then click the 
three-dot button to open the SQL Builder.
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The SQL Builder editor is made of the following panels:

• Database structure

• Query editor made of editor and designer tabs

• Query execution view

• Schema view

The Database structure shows the tables for which a schema was defined either in the Repository 
database entry or in your built-in connection.

The schema view, in the bottom right corner of the editor, shows the column description.

4.12.1 Database structure comparison

On the Database Structure panel, you can see all tables stored in the DB connection metadata entry 
in the Repository tree view, or in case of built-in schema, the tables of the database itself.

The connection to the database, in case of built-in schema or in case of a refreshing 
operation of a repository schema might take quite some time.
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Click the refresh icon to display the differences found between the DB metadata tables and the actual 
DB tables. 

The Diff icons point out that the table contains differences or gaps. Expand the table node to show 
the exact column containing the differences. 

The red highlight shows that the content of the column contains differences or that the column is 
missing from the actual database table.

The blue highlight shows that the column is missing from the table stored in Repository > 
Metadata.

4.12.2 Building a query

The Query editor is a multiple-tab system allowing you to write or graphically design as many 
queries as you want. 

To create a new query, right-click the table or on the table column and select Generate Select 
Statement on the pop-up list.

Click the empty tab showing by default and type in your SQL query or press Ctrl+Space to access 
the autocompletion list. The tooltip bubble shows the whole path to the table or table section you 
want to search in.  
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Alternatively the graphical query Designer allows you to handle tables easily and have real-time 
generation of the corresponding query in the Edit tab.

Click the Designer tab to switch from the manual Edit mode to the graphical mode.

You may get a message while switching from one view to the other as some SQL 
statements cannot be interpreted graphically.

If you selected a table, all columns are selected by default. Clear the check box facing the relevant 
columns to exclude them from the selection. 

Add more tables in a simple right-click. On the Designer view, right-click and select Add tables in 
the pop-up list then select the relevant table to be added.

If joins between these tables already exist, these joins are automatically set up graphically in the 
editor.

You can also very easily create a join between tables. Right-click the first table columns to be linked 
and select Equal on the pop-up list, to join it with the relevant field of the second table. 
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The SQL statement corresponding to your graphical handlings is also displayed on the viewer part 
of the editor or click the Edit tab to switch back to the manual Edit mode. 

In the Designer view, you cannot include graphically filter criteria. You need to add 
these in the Edit view.

Once your query is complete, execute it by clicking on the running man button.

The toolbar above the query editor allows you to access quickly usual commands such as: execute, 
open, save and clear.

On the Query results view, are displayed the results of the active tab’s query. 

The status bar at the bottom of this panel provides information about execution time and number of 
rows retrieved.

4.12.3 Storing a query in the Repository

To be able to retrieve and reuse queries, we recommend you to store them in the Repository.

In the SQL Builder editor, click Save (floppy disk icon on the tool bar) to bind the query with the 
DB connection and schema in case these are also stored in the Repository.

The query can then be accessed from the Database structure view, on the left-hand side of the 
editor.

4.13 Defining Contexts and variables

Depending on the circumstances the Job is being used in, you might want to manage it differently for 
various execution types (Prod and Test in the example given below). For instance, there might be various 
stages of test, you want to perform and validate before a Job is ready to go live for production use. 
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Talend Open Studio offers you the possibility to create multiple context data sets. Furthermore you can 
either create context data sets on a one-shot basis, from the context tab of a Job or you can centralize 
the context data sets in the Contexts area of the Repository in order to reuse them in different Jobs. 

A context is characterized by parameters. These parameters are mostly context-sensitive variables which 
will be added to the list of variables available for reuse in the component-specific properties on the 
Component view through the Ctrl+Space bar keystrokes.

4.13.1 Using variables in a Job

In any properties field defining a component, you can use an existing global variable or a context 
variables.

Press Ctrl+Space bar to display the whole list of global and context variables used in various 
predefined Perl or Java functions. The context variables are created by the user for a particular 
context, whereas the global variables are a system variables.

The list grows along with new user-defined variables (context variables).

Related topics: 

• Defining variables from the Component view on page 122

• Defining variables on the Contexts view on page 117

4.13.2 Defining variables on the Contexts view

Various ways are at your disposal to create and define variables. You can manage your variables 
through the Contexts view or directly on the Component view.

For more information regarding the variable definition directly on the Component view, 
see Defining variables from the Component view on page 122.

The Contexts view is positioned on the lower part of the design workspace and is made of three tabs: 
Variables, Values as tree and Values as table.

If you cannot find the Contexts view on the tab system of Talend Open Studio, go to 
Window > Show view > Talend, and select Contexts.

Variables tab

The Variables tab is part of the Contexts tab and shows all variables that have been defined for 
each component of the current Job. 
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From this panel, you can manage your built-in variables:

• Add a parameter line to the table by clicking on Plus (+) 

• Edit the Name of the new variable and type in the <Newvariable> name.

• Delete built-in variables. (Reminder: Repository variables are read-only.)

• Import variables from a Repository context source, through the Repository variables  
button.

To define the actual value of the newly created variable, click the Value as tree tab.

You can add as many entries as you need on the Variables tab. By default the variable created 
is of built-in type.

Fields Description

Name Name of the variable. You can edit this field, on the condition 
that the variable is of Built-in type. Indeed repository variables 
are read-only.

Source Built-in: The variable is created in this Job and will be used in 
this Job only.   
<Repository entry name>: The variable has been defined in a 
context stored in the Repository. The source is thus the actual 
context group you created in the Repository

Type Select the type of data being handled. This is required in Java.

Script code Code corresponding to the variable value. It depends on the 
Generation language you selected (Java or Perl) such as in Perl:  
$_context{YourParameterName. This Script code is 
automatically generated when you define the variable in the 
Component view.

Comment Add any useful comment

Add
Remove

Repository variables
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You cannot create contexts from the Variables view, but only from the Values as 
table or as tree views.

For further information regarding variable definition on the component view, see Defining 
variables from the Component view on page 122.

For more information about the repository variables, see Storing contexts in the Repository on 
page 124.

Values as tree tab

This tab shows the variables as well as their values in the form of a tree.

From this view, you can:

• Define the value of a built-in variable directly in the Value field. Note that repository 
variables values are read-only and can only be edited in the relevant repository context.

• Define a question to prompt the user for variable value confirmation at execution time.

• Create or Edit a context name through the top right dedicated button. 

• Rearrange the variable/context groupby display 

Fields Description

Variable Name of the variables.

Context Name of the contexts.  

Prompt Select this check box, if you want the variable to be editable in the 
confirmation dialog box at execution time.

If you asked for a prompt to popup, fill in this field to define the message 
to show on the dialog box.

Value Value for the corresponding variable. Define the value of your built-in 
variables. Note that repository variables are read-only. 
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You can manage your contexts from this tab, through the dedicated button placed on the top right 
hand side of the Contexts view. See Configuring contexts on page 120 for further information 
regarding the context management.

On the Values as tree tab, you can display the values based on the contexts or on the variables 
for more clarity. 

To change the way the values are displayed on the tree, click the small down arrow button, then 
click the group by option you want.

For more information regarding variable definition, see Defining variables from the Component 
view on page 122 and Storing contexts in the Repository on page 124.

Values as table tab

This Values as table tab shows the context and variable settings in the form of a table.

You can manage your contexts from this tab, through the Configure contexts button placed on 
the top right hand side of the Contexts panel. See Configuring contexts on page 120 for further 
information regarding the context management.

For more information regarding variable definition, see Defining variables from the Component 
view on page 122 and Storing contexts in the Repository on page 124.

4.13.3 Configuring contexts

You can only manage your contexts from the Values as table or Values as tree tabs. A dedicated 
button shows up on the top right hand side of the Contexts view.

Fields Description

Name Name of the variable.

<YourContextName> Corresponding value for the variable.

Context configuration

Groupby 
Variables/Contexts
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Click the Configure Contexts... icon to open the management dialog box.

The default context cannot be removed, therefore the Remove button is unavailable. 
To make it editable, select another context on the list.

Creating a context

Based on the default context you set, you can create as many contexts as you need.

• To create a new context, click New on the [Configure Contexts] dialog box.

• Type in a name for the new context. 

Configure contexts 
icon
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Click OK to validate the creation.

When you create a new context, the entire default context legacy is copied over to the new 
context.You hence only need to edit the relevant fields on the Value as tree tab to customize the 
context according to your use.

The drop-down list Default Context shows all the contexts you created.

You can switch default context by simply selecting the new default context on the Default 
Context list on the Variables tab of the Contexts view.

Note that the Default (or last) context can never be removed. There should always be a context 
to run the Job, be this context called Default or any other name.

Renaming or editing a context

To change the name of an existing context, click Edit on the [Configure contexts] dialog box 
and enter the new context name in the dialog box showing up.

Click OK to validate the change.

To carry out changes on the actual values of the context variables, go to the Values as tree or 
Values as table tabs. For more information about these tabs, see Defining variables on the 
Contexts view on page 117.

4.13.4 Defining variables from the Component view  

Various ways are at your disposal to create and define context variables. You can mostly manage 
your variables from the Contexts view, but you can also create them directly on the Component 
view.

For more information related to the variable definition through the Contexts view, see Defining 
variables on the Contexts view on page 117.

For more information regarding the variable definition in the Repository, see Storing contexts in the 
Repository on page 124.

Short creation of context variables

The quickest way to create context variables on the spot is to use the F5 key:

• On the relevant Component view, place your cursor on the field that you want to 
parameterize. 

• Press F5 to display the context parameter dialog box:
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• Give a Name to this new variable, fill in the Comment area and choose the Type.

• Enter a Prompt to be displayed to confirm the use of this variable in the current Job 
execution (generally used for test purpose only). And select the Prompt for value check 
box to display the field as editable value.

• If you filled in a value already in the corresponding properties field, this value is 
displayed in the Default value field. Else, type in the default value you want to use for 
one context.

• Click Finish to validate. 

• Go to the Contexts view tab. Notice that the context variables tab lists the newly created 
variables.

The newly created variables are listed in the Contexts view.

The variable name should follow some typing rules and should not contain any 
forbidden characters, such as space char.

The variable created this way is automatically stored in the Default context, but you can change 

the context name through the Configure Context  icon.

For more information on how to create or edit a context, see Configuring contexts on page 120.

StoreSQLQuery

StoreSQLQuery is a user-defined variable and is dedicated to debugging mainly.
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StoreSQLQuery is different from other context variables in the fact that its main purpose is to 
be used as parameter of the specific global variable called Query. It allows you to dynamically 
feed the global query variable. 

The global variable Query, is available on the proposals list (Ctrl+Space bar) for some DB 
input components.

For further details on StoreSQLQuery settings, see the Talend Open Studio Components 
Reference Guide, and in particular tDBInput Scenario 2: Using StoreSQLQuery variable.

4.13.5 Storing contexts in the Repository

You can store centrally all contexts if you need to reuse them across various Jobs. 

Creating a context group

Right-click the Contexts node in the Repository tree view and select Create new context 
group in the list.

A 2-step wizard helps you to define the various contexts and context parameters, that you’ll be 
able to select on the Contexts view of the design workspace.

• On the Step 1, type in a name for the context group to be created.

• Add any general information such as a description.

• Click Next. 

The Step 2 allows you to define the various contexts and variables that you need.
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First define the default context’s variable set that will be used as basis for the other contexts.

• On the Variables tab, click the Plus (+) button to add as many new variable lines as 
needed and define the name of the variables. In this example, we define the variables that 
could be used in the Name field of the Component view. 

• Select the Type of variable on the list. 

• The Script code varies according to the type of variable you selected (and the generation 
language). It will be used in the generated code. The screen shot above shows the Java 
code produced.

On the Tree or Table views, define the various contexts and the values of the variables.

• Define the values for the default (first) context variables.

• Then create a new context that will be based on the variables values that you just set. For 
more information about how to create a new context, see Configuring contexts on 
page 120. 

On the Values as tree tab, you can also add a prompt if you want the variable to be editable in 
a confirmation dialog box at execution time.

• To add a prompt message, select the facing check box. 

• And type in the message you want to display at execution time.

Once you created and adapted as many context sets as you want, click Finish to validate. The 
group of contexts thus displays under the Contexts node in the Repository. 

To apply a context to a Job, click the Contexts tab, select Repository as Context type. 

Then select the relevant Context from the Repository. The selected context’s parameters show 
as read-only values.
Creative Commons License Talend Open Studio 125

http://creativecommons.org/licenses/by-nc-sa/2.0/


Designing a Job
Running a Job
Creating a context from a Metadata 

When creating a Metadata (through the File or DB metadata wizards), you have the possibility 
to Export the metadata connection information as a Context.

For more information about this feature, see Exporting a Metadata as context on page 179.

4.13.6 Running a Job in selected context

You can select the context you want the job design to be executed in. 

Click the Run Job tab, and in the Context area, select the relevant context 
among the various ones you created. 

If you didn’t create any context, only the Default context shows on the 
list.

All the context variables you created for the selected context display, 
along with their respective value, in a table underneath. If you clear the 
Prompt check box next to some variables, you will get a dialog box 

allowing you to change the variable value for this job execution only. 

To make a change permanent in a variable value, you need to change it on the Context view if your 
variable is of type built-in or in the Context group of the Repository. 

Related topics: 

• Defining variables on the Contexts view on page 117

• Storing contexts in the Repository on page 124

4.14 Running a Job

You can execute a Job in several ways. This mainly depends on the purpose of your job execution and 
on your user level. 

If you are an advanced Perl/Java user and want to execute your Job step by step to check and possibly 
modify it on the run, see Running in debug mode on page 130. 

If you do not have advanced Perl knowledge and want to execute and monitor your Job in normal mode, 
see Running in normal mode on page 126.

4.14.1 Running in normal mode

Make sure you saved your Job before running it in order for all properties to be taken into account.

• Click the Run Job tab to access the panel. 

• In the Context area, select the proper context for the Job to be executed in. You can also 
check the variable values

If you haven’t defined any particular execution context, the context parameter table is empty and the 
context is the default one. Related topic: Defining Contexts and variables on page 116

• Click Run to start the execution.
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• On the same panel, the console displays the progress of the execution. The log includes any 
error message as well as start and end messages. It also shows the job output in case of 
tLogRow component is used in the job design. 

Before running again a Job, you might want to remove the log content from the execution panel. 
Select the Clear before run check box, for the log to be cleared each time you execute again a Job.

If for any reason, you want to stop the Job in progress, simply click Kill button. You’ll need to click 
the Run button again, to start again the Job.

Talend Open Studio offers various informative features, such as statistics and traces, facilitating the 
job monitoring and debugging work.

Displaying Statistics

The Statistics feature displays each component performance rate, under the flow links on the 
design workspace. 

It shows the number of rows processed and the processing time in row per second, allowing you 
to spot straight away any bottleneck in the data processing flow.

For trigger links like OnComponentOK, OnComponentError, OnSubjobOK, 
OnSubjobError and If, the Statistics option displays the state of this trigger during the 
execution time of your Job: Ok or Error and True or False.

Note: Exception is made for external components which cannot offer this feature if their design 
doesn’t include it. 

Select the Statistics check box to activate the stats feature and click again to disable it.

The calculation only starts when the job execution is launched, and stops at the end of it.

Click Clear to remove the calculated stats displayed. Select the Clear before Run check box 
to reset the Stats feature before each execution.
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The statistics thread slows down job execution as the Job must send these stats 
data to the design workspace in order to be displayed.

Displaying Traces

The Traces feature allows you to monitor data processing when running a Job in Talend Open 
Studio. 

It provides a row by row view of the component behavior and displays the dynamic result next 
to the Row link. 

This feature allows you to monitor all the components of a Job, without switching to Debug 
mode, hence without requiring advanced Perl/Java knowledge. 

The Traces function displays the content of processed rows in a table. 

Exception is made for external components which cannot offer this feature if their 
design doesn’t include it.

Activating the Traces mode

To activate the Traces mode in a Job:

• Select the Traces check box from the Run view. An icon displays under every flow 
of your Job to indicate that process monitoring is activated. 

Deactivating the Traces mode on a flow

To deactivate the Traces on one of the flows in your Job:
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• Right-click the Traces icon under the relevant flow, then select Disable Traces from 
the list. A red minus sign replaces the green plus sign on the icon to indicate that the 
Traces mode has been deactivated for this flow. 

Selecting the columns to display in the Traces table

If you want to choose which columns of processed data to display, do as follows: 

• Right-click the Traces icon for the relevant flow, then select Setup Traces from the 
list. The [Setup Traces] dialog box displays.

• In the dialog box, clear the check boxes corresponding to the columns you do not 
want to display in the Traces table.

• Click OK to close the dialog box.

 Monitoring data processing starts when you execute the Job and stops at the end of the 
execution. 

Click Clear to remove the displayed monitoring information.

Displaying the execution time and other options

Simply select the Exec time check box before running the Job, for the total execution time to 
be displayed at the end of the Job.

This way you can bench the solution or test your Job before going to production.

You can also clear the design workspace before each job execution by selecting the check box 
Clear before Run.
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You can also save your Job before the execution starts. Select the relevant option check box.

4.14.2 Running in debug mode

Note that to run a Job in Debug mode, you need the EPIC module to be installed.

Before running your Job in Debug mode, add breakpoints to the major steps of your job flow.  

This will allow you to get the Job to automatically stop at each breakpoint. This way 
components and their respective variables can be verified individually and debugged 
if required.

To add breakpoints to a component, right-click it on the design workspace, and select 
Add breakpoint on the popup menu.

A pause icon displays next to the component where the break is added. 

To switch to debug mode, click the Debug button on the Run Job panel. Talend Open Studio’s 
main window gets reorganized for debugging.  

You can then run the Job step by step and check each breakpoint component for the expected 
behavior and variable values.

To switch back to Talend Open Studio designer mode, click Window, then Perspective and select 
Talend Open Studio. 

4.15 Managing Metadata and Context updates

You can update the metadata that you defined, or the context parameters, at any time and for any Jobs, 
in order to update the database connection details, for example. Simply right-click the relevant 
repository metadata or context entry that you need to update and select Edit on the contextual menu. 

The respective wizard will open that allows you to edit each of the definition steps.

When updating metadata information or when modifying context information of any nature, you might 
want to propagate the changes throughout numerous Jobs or all your Jobs that are using these metadata 
or contexts.

A prompt message pops up automatically at the end of your update/modification process, that lets you 
implement the changes throughout all Jobs impacted by these changes. 

You can propagate your changes in two manners:

• automatically, and straight after you made a change in the Metadata or Context entry if you click 
Yes. For more information, see Updating all Jobs automatically on page 131.
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• or manually, on a one by one basis, if you click No. For more information, see Managing 
dependencies on page 131.

4.15.1 Updating all Jobs automatically

Click Yes when prompted, if you want the Update manager  to scan your Repository for the Jobs 
that get impacted by the change you just made. The aim being of automatically propagating the 
update throughout all your Jobs (open or not) in only one operation. 

Clear the check box in front of the Jobs you do not wish to update. You can update them later through 
a manual operation, see Managing dependencies on page 131 for more information.

Click OK to validate and update all selected Jobs.

4.15.2 Managing dependencies

Click NO when prompted, if you do not want to spread the metadata or context changes throughout 
all your Jobs that use this metadata or context. This function allows you to propagate the update 
manually rather than automatically as it might be quite time-consuming to have an automatic 
propagation, if your project stores a very large number of Jobs.

For more information about how to select Jobs to be updated, see Managing dependencies on 
page 131.

Before propagating changes from the Repository > Metadata or Contexts throughout all your 
Jobs, you might want to view the impacts that is implied.

• After you made a change to a metadata entry or context entry, click No when prompted for 
propagating the changes to all Jobs.

• Then right-click the relevant metadata entry or context entry to display the contextual menu.

• Select Manage dependencies on the menu
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• Select or clear the check boxes of the Jobs that should be updated.

• Click OK when your selection is complete.

The Jobs that you choose not to update will be switched back to Built-in, as the link 
to the repository cannot be maintained. It will thus keep the setting as it was before the 
change.

4.16 Activating/Disabling a Job or sub-job

You can enable or disable the whole Job or a sub-job directly connected to the selected component. By 
default, a component is activated. 

In the Main properties of the selected component, select or clear the Activate check box. 
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Alternatively, right-click the component and select the relevant Activate/Deactivate command 
according to the current component status. 

If you disable a component, no code will be generated, you will not be able to add or modify links from 
the disabled component to active or new components.

Related topic: Defining the Start component on page 89.

4.16.1 Disabling a Start component

In the case the component you deactivated is a Start component, components of all types and links 
of all nature connected directly and indirectly to it will get disabled too.

4.16.2 Disabling a non-Start component

When you clear the Activate check box of a regular (non Start) component, are deactivated only the 
selected component itself along with all direct links. 

If a direct link to the disabled component is a main Row connection to a sub-job. All components 
of this sub-job will also get disabled.

4.17 Saving or exporting your jobs

4.17.1 Saving a Job

When closing a Job or Talend Open Studio, a dialog box prompts you to save the currently open 
Jobs if not already done. 

In case several Jobs are to close together, select the check box facing the Jobs you want to save. The 
Job is stored in the relevant project folder of your workspace directory.

Alternatively, click File > Save or press Ctrl+S.
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4.17.2 Exporting Job scripts

For detailed procedure for exporting Jobs outside Talend Open Studio, see Exporting job scripts 
on page 184.

4.18 Documenting a Job

4.18.1 Generating HTML documentation

Talend Open Studio allows you to produce detailed documentation in HTML of the Jobs selected. 
This documentation offers: descriptions of projects, Jobs and components, job view parameters, job 
preview, the list of all components used and the list of the contexts used along with their value.

• In the Repository, right-click a Job entry or select several Job Designs to produce multiple 
documentations. 

• Select Generate Doc as HTML on the pop-up menu.

• Browse to the location where the generated documentation archive should be stored.

• In the same field, type in a Name for the archive gathering all generated documents.

• Click Finish to validate the generation operation.

The archive file contains all required files along with the Html output file. Open the html file in your 
favorite browser.

4.18.2 Updating the documentation on the spot

You can choose to manually update your documentation on the spot.
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To update a single document, right-click the relevant documentation entry and select Update 
documentation.

4.19 Searching a Job in the Repository

If you want to open a specific Job in the Repository of the current Talend Open Studio and you can not 

find it for one reason or another, you can simply click  on the Quick access toolbar.

To find a Job in the Repository:

• On Talend Open Studio toolbar, click  to open the [Find a Job] dialog box that lists 
automatically all the Jobs you created in the current Studio.

• Enter job name or part of job name in the upper field. 
When you start typing your text in the field, the job list is updated automatically to display only 
the Job(s) which name(s) match(es) the letters you typed in.
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• Select the desired Job from the list and click Link Repository to automatically browse to the 
selected Job in the Repository tree view.

• If needed, click Cancel to close the dialog box and then right-click the selected Job in the 
Repository tree view to perform any of the available operations in the contextual menu. 

• Otherwise, click Ok to close the dialog box and open the selected Job on the design workspace.

4.20 Defining options on the Job view

On the Job view located on the bottom part of the design workspace, you can define Job’s optional 
functions. This view is made of two tabs: Stats & Logs tab and Extra tab.

The Stats & Logs tab allows you to automate the use of Stats & Logs features and the Context loading 
feature. For more information, see Automating statistics & logs use on page 136.

The Extra tab lists various options you can set to automate some features such as the context parameters 
use, in the Implicit Context Loading area. For more information, see Extra features on page 137.

4.20.1 Automating statistics & logs use

If you have a great need of log, statistics and other measurement of your data flows, you are facing 
the issue of having too many log-related components loading your job designs. You can automate 
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the use of  tFlowMeterCatcher, tStatCatcher, tLogCatcher component functionalities without 
using the components in your Job via the Stats & Logs tab.

For more information regarding the Log component, see the Talend Open Studio Components 
Reference Guide.

The Stats & Logs panel is located on the Job tab underneath the design workspace and prevents 
your jobs designs to be overloaded by components. 

 
This setting supersedes the log-related components with a general log configuration.

To set the Stats & Logs properties:

• Click the Job tab.

• Select the Stats & Logs panel to display the configuration view.

• Set the relevant details depending on the output you prefer (console, file or database).

• Select the relevant Catch check box according to your needs.

You can automatically save the settings into your Preference. Or else, you can access 
the preferences via Window > Preferences > Talend > Stats & Logs.

When you use Stats & Logs functions in your Job, you can apply them to all its subjobs.

To do so, click the Apply to subjobs button in the Stats & Logs panel of the Job view and the 
selected stats & logs functions of the main Job will be selected for all of its subjobs.

4.20.2 Extra features

The Extra tab offers some optional function parameters.
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• Select the Multithread execution check box to allow two job executions to start at the same 
time.

• Set the Implicit tContextLoad option parameters to avoid using the tContextLoad 
component on your Job and automate the use of context parameters. 
Choose between File or Database as source of your context parameters and set manually the 
file or database access.  
Set notifications (error/warninginfo) for unexpected behaviors linked to context parameter 
setting.

• When you fill in Implicit tContextLoad manually, you can store these parameters in your 
project by clicking the Save to project settings button, and thus reuse these parameters for 
other components in different Jobs.

• Select the Use Project Settings check box to recuperate the context parameters you have 
already defined in the Project Settings view.  
The Implicit tConextLoad option becomes available and all fields are filed in 
automatically. 
For more information about context parameters, see Context settings on page 48.

• Click Reload from project settings to update the context parameters list with the latest 
context parameters from the project settings.

4.21 Customizing the Palette

You can select the components to be shown or hidden on your Palette. You can also add to the Palette 
the components that you developed yourself.  

For more information about filtering the Palette, see Customizing project settings on page 44.

For more information about adding components to the Palette, either from Talend Exchange or from 
your own development, see Talend Exchange view on page 31 and/or External or User components on 
page 36.

4.22 Shortcuts and aliases

Below is a table gathering all keystrokes currently in use:

Shortcut Operation Context

F2 Shows Component settings view Global application

F4 Shows Run Job view Global application

F6 Runs current Job or shows Run Job view if no 
Job is open.

Global application

Ctrl + F2 Shows Module view Global application

Ctrl + F3 Shows Problems view Global application

Ctrl + H Shows the Designer view of the current Job Global application

Ctrl + G Shows the Code view of the current Job Global application

Ctrl + R Restores the initial Repository view From Repository view

Ctrl + Shift + F3 Synchronizes components perljet templates and 
associated java classes

Global application
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Ctrl + Shift + J Opens a Job Global application (In Windows)

F7 Switches to Debug mode From Run Job view

F5 Refreshes the Repository view From Repository view

F8 Kills current Job From Run Job view 

F5 Refreshes Modules install status From Modules view

Ctrl+L Execute SQL queries Talend commands (in Windows)

Ctrl+Space bar Access global and user-defined variables. It can 
be error messages or line number for example, 
depending on the component selected.

From any component field in Job 
or Component views 

Shortcut Operation Context
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CHAPTER 5 

Managing Metadata
Metadata in Talend Open Studio is definitional data that provides information about or 
documentation of other data managed within Talend Open Studio.

This chapter provides procedures to create and manage various metadata items that can be used in 
all your job designs.
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5.1 Objectives

The Metadata folder in the Repository tree view stores reusable information on files, databases, and/or 
systems that you need to build your jobs.

Various corresponding wizards help you store these pieces of information and use them later to set the 
connection parameters of the relevant input or output components, but you can also store the data 
description called “schemas” in Talend Open Studio.

Wizards’ procedures slightly differ depending on the type of connection chosen.

Click Metadata in the Repository tree view to expand the folder tree. Each of the connection nodes will 
gather the various connections you set up.

From Talend Open Studio, you can set up: 

• a DB connection.

• a JDBC schema.

• a file schema.

• an LDAP schema.

• a generic schema.

• a WSDL schema.

• a salesforce schema.

The following sections explain in detail how to set up different connections and schemas.

5.2 Setting up a DB connection

If you often need to connect to database tables of any kind, then you may want to centralize the 
connection information details in the Metadata folder in the Repository tree view. 

You can also set up a DB connection the same way by clicking the icon in the Basic 
settings view of all input and output DB components.

5.2.1 Step 1: general properties

The creation procedure is made of two separate but closely related operations. First expand 
Metadata in the Repository tree view and right-click Db Connections and select Create 
connection on the pop-up menu.

The connection wizard opens up. Fill in the generic Schema properties such as Schema Name and 
Description. The Status field is a customized field you can define in Window > Preferences. 
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Click Next when completed, the second step requires you to fill in DB connection data. 

5.2.2 Step 2: connection

Select the type of Database you want to connect to and some fields will be available/unavailable 
according to the DB connection detail requirements.
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Fill in the connection details and click Check to check your connection.

Fill in, if need be, the database properties information. That is all for the first operation on DB 
connection setup, click Finish to validate.

The newly created DB connection is now available in the Repository and displays four folders 
including Queries (for SQL queries you save) and Table schemas that will gather all schemas 
linked to this DB connection.
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Right-click the newly created connection, and select Retrieve schema on the drop-down list.

5.2.3 Step 3: table upload

A new wizard opens up on the first step window. The schema List offers all tables present on the 
DB connection. It can be any type of databases. 

Select one or more tables on the list to load them onto your Repository file system. You will base 
your repository schemas on these tables. 

If no schema is visible on the list, click Check connection to verify the DB connection status. 

Click Next. On the next window, four setting panels help you define the schemas to create.

In Java, make sure the data type is correctly defined.  
For more information regarding data types, including date pattern, check out 
http://java.sun.com/j2se/1.5.0/docs/api/index.html.

5.2.4 Step 4: schema definition

By default, the schema displayed on the Schema panel is based on the first table selected in the list 
of schemas loaded (left panel). You can change the name of the schema and according to your needs, 
you can also customize the schema structure in the schema panel. 

Indeed, the tool bar allows you to add, remove or move columns in your schema. In addition, you 
can load an xml schema from a file or export the current schema as xml. 

To retrieve a schema based on one of the loaded table schemas, select the DB table schema name 
in the drop-down list and click Retrieve schema. Note that the retrieved schema then overwrites any 
current schema and does not retain any custom edits.

Click Finish to complete the DB schema creation. All created schemas display under the relevant 
DB connections node. 
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5.3 Setting up a JDBC schema

For DB table based schemas, the creation procedure is made of two separate but closely related 
operations. First Right-click Db Connections and select Create connection on the pop-up menu.

5.3.1 Step 1: general properties

Fill in the schema generic information, such as Schema Name and Description.

For further information, see Step 1: general properties on page 142.

5.3.2 Step 2: connection

Select the type of Database you want to connect to and fill in the DB connection details.

Fill in the connection details below:
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• Fill in the JDBC URL used to access the DB server.

• In the Driver jar field, select the jar driver validating your connection to the database.

• In the Class name field, fill in the main class of the driver allowing to communicate with the 
database.

• Fill in your User name and Password.

• In the Mapping File field, select the mapping allowing the DB Type to match the Java or 
Perl Type of data on the schema. For example: the DB Type VARCHAR correspond to the 
String Type for Java and Perl.

The Mapping files are XML files that you can access via Window > Preferences > 
Talend > Metadata of TalendType.

Click Check to check out your connection.

Fill in, if need be, the database properties information. That is all for the first operation on DB 
connection setup, click Finish to validate.

The newly created DB connection is now available in the Repository tree view and it displays four 
folders including Queries (for the SQL queries you save) and Table schemas that will gather all 
schemas linked to this DB connection.

Right-click the newly created connection, and select Retrieve schema on the drop-down list.

5.3.3 Step 3: table upload

A new wizard opens up on the first step window. The List offers all tables present on the DB 
connection. It can be any type of databases. 

Select one or more tables on the list, to load them onto your Repository file system.You will base 
your repository schemas on these tables. 

If no schema is visible on the list, click Check connection, to verify the DB connection status. 

Click Next. On the next window, four setting panels help you define the schemas to create.
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In Java, make sure the data type is correctly defined. For more information regarding data types, 
including date pattern, check out http://java.sun.com/j2se/1.5.0/docs/api/index.html.

5.3.4 Step 4: schema definition

By default, the schema displayed on the Schema panel is based on the first table selected in the list 
of schemas loaded (left panel). You can change the name of the schema and according to your needs, 
you can also customize the schema structure in the schema panel. 

Indeed, the tool bar allows you to add, remove or move columns in your schema. In addition, you 
can load an xml schema from a file or export the current schema as xml. 

To retrieve a schema based on one of the loaded table schemas, select the DB table schema name 
in the drop-down list and click Retrieve schema. Note that the retrieved schema then overwrites any 
current schema and doesn’t retain any custom edits.

Click Finish to complete the DB schema creation. All created schemas display under the relevant 
DB connections node. 

5.4 Setting up a SAS connection

Talend Open Studio enables you to configure a connection to a remote SAS system.

5.4.1 Prerequisites

Before carrying on the below procedure to configure your SAS connection, make sure that you 
retrieve your metadata from the SAS server and export it XML format.  

5.4.2 Step 1: General properties

• In the Repository tree view of Talend Open Studio, expand Metadata and then right-click 
DB Connection.

• Select Create connection from the contextual menu to open the [Database Connection] 
wizard.

• Fill in schema generic information, such as Name and Description and click Next to open 
a new view on the wizard.

For further information, see Step 1: general properties on page 142.

5.4.3 Step 2: Connection

• In the DB type field in the [Database Connection] wizard, select SAS and fill in the fields 
that follow with SAS connection information.
148 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/
http://java.sun.com/j2se/1.5.0/docs/api/index.html
http://java.sun.com/j2se/1.5.0/docs/api/index.html


Managing Metadata
Setting up a SAS connection
• If needed, click the Check tab to verify if your connection is successful.

• If needed, define the properties of the database in the corresponding fields In the Database 
Properties area. 

• Click Finish to validate your changes and close the wizard.

The newly set connection to the defined database displays under the DB Connections folder in the 
Repository tree view. This connection has four sub-folders among which Table schemas can group 
all schemas relative to this connection.
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• Right-click the SAS connection you created and then select Retrieve Schema from SAS to 
display all schemas in the defined database under the Table schemas sub-folder.

5.5 Setting up a File Delimited schema

File delimited metadata can be used for both tFileInputDelimited and tFileInputCSV components as 
both csv and delimited files are based on the same type of structure.

The file schema creation is very similar for all types of file connections: Delimited, 
Positional, Regex, Xml, or Ldif.

In the Repository tree view, right-click File Delimited, and select Create file delimited on the pop-up 
menu.

Unlike the DB connection wizard, the Delimited File wizard gathers both file connection and schema 
definition in a four-step procedure.

5.5.1 Step 1: general properties

On the first step, fill in the schema generic information, such as Schema Name and Description.

For further information, see Step 1: general properties on page 142.
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5.5.2 Step 2: file upload

Define the Server IP address where the file is stored. And click Browse... to set the File path.

Select the OS Format the file was created in. This information is used to prefill subsequent step 
fields. If the list doesn’t include the appropriate format, ignore it.

The File viewer gives an instant picture of the file loaded. It allows you to check the file consistency, 
the presence of header and more generally the file structure.

Click Next to Step3.

5.5.3 Step 3: schema definition

On this view, you can refine your data description and file settings. Click the squares below, to zoom 
in and get more information. 
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Set the Encoding, as well as Field and Row separators in the Delimited File Settings. 

Depending on your file type (csv or delimited), you can also set the Escape and Enclosure characters 
to be used.
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If the file preview shows a header message, you can exclude the header from the parsing. Set the 
number of header rows to be skipped. Also, if you know that the file contains footer information, 
set the number of footer lines to be ignored.

The Limit of rows allows you to restrict the extend of the file being parsed.

In the File Preview panel, you can view the new settings impact.

Check the Set heading row as column names box to transform the first parsed row as labels for 
schema columns. Note that the number of header rows to be skipped is then incremented of 1.

Click Refresh on the preview panel for the settings to take effect and view the result on the viewer.

5.5.4 Step 4: final schema

The last step shows the Delimited File schema generated. You can customize the schema using the 
toolbar underneath the table.
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If the Delimited file which the schema is based on has been changed, use the Guess button to 
generate again the schema. Note that if you customized the schema, the Guess feature doesn’t retain 
these changes.

Click Finish. The new schema displays in the Repository tree view, under the relevant File 
Delimited connection node.

5.6 Setting up a File Positional schema

In the Repository tree view, right-click File Positional tree node, and select Create file positional on 
the pop-up menu. 
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Proceed the same way as for the file delimited connection. Right-click Metadata in the Repository tree 
view and select Create file positional.

5.6.1 Step 1: general properties

 Fill in the schema generic information, such as Schema Name and Description.

5.6.2 Step 2: connection and file upload

Then define the positional file connection settings, by filling in the Server IP address and the File 
path fields. 

Like for Delimited File schema creation, the format is requested to pre-fill the next step fields. If 
the file creation OS format is not offered in the list, ignore this field.

The file viewer shows a file preview and allows you to place your position markers. 
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Click the file preview and set the markers against the ruler. The orange arrow helps you refine the 
position.

The Field separator lists a series of figures separated by commas, these are the number of 
characters between the separators. The asterisk symbol means all remaining characters on the row, 
starting from the preceding marker position.

The Marker Position shows the exact position of the marker on the ruler. You can change it to refine 
the position. 

You can add as many markers as needed. To remove a marker, drag it above the ruler. 

Click Next to continue.

5.6.3 Step 3: schema refining

The next step opens the schema setting window. As for the Delimited File schema, you can refine 
the schema definition by setting precisely the field and row separators, the header message lines and 
more...

At this stage, the preview shows the file delimited upon the markers’ position. If the file contains 
column labels, select the check box Set heading row as column names. 

5.6.4 Step 4: final schema

Step 4 shows the final generated schema. Note that any character which could be misinterpreted by 
the program is replaced by neutral characters, like underscores replace asterisks. 

You can add a customized name (by default, metadata) and make edits to it using the tool bar. 

You can also retrieve or update the Positional File schema by clicking on Guess. Note however that 
any edits to the schema might be lost after “guessing” the file-based schema.

5.7 Setting up a File Regex schema

Regex file schemas are used for files containing redundant information, such as log files.
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Proceed the same way as for the file delimited or positional connection. Right-click Metadata in the 
Repository tree view and select Create file regex.

5.7.1 Step 1: general properties

 Fill in the schema generic information, such as Schema Name and Description.

5.7.2 Step 2: file upload

Then define the Regex file connection settings, by filling in the Server IP address and the File path 
fields. 

Like for Delimited File schema creation, the format is requested for pre-fill purpose of next step 
fields. If the file creation OS format is not offered in the list, ignore this field.

The file viewer gives an instant picture of the loaded file. Click Next to define the schema structure.
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5.7.3 Step 3: schema definition

This step opens the schema setting window. As for the other File schemas, you can refine the schema 
definition by setting precisely the field and row separators, the header message number of lines and 
else...

In the Regular Expression settings panel, enter the regular expression to be used to delimit the file. 
(below in Perl) 

Make sure to use the correct Regex syntax according to the generation language you 
use as the syntax is different in Java/Perl, and to include the Regex in single or double 
quotes accordingly.

Then click Refresh preview to take into account the changes. The button changes to Wait until the 
preview is refreshed.

Click next when setting is complete. The last step generates the Regex File schema.

5.7.4 Step 4: final schema

You can add a customized name (by default, metadata) and make edits to it using the tool bar. 

You can also retrieve or update the Regex File schema by clicking on Guess. Note however that any 
edits to the schema might be lost after guessing the file based schema.

Click Finish. The new schema displays in the Repository tree view under the relevant File regex 
connection node.

5.8 Setting up a File XML schema  

Centralize your XPath query statements over a defined XML file and gather the values fetched from it.

Proceed the same way as for other file connections. Right-click Metadata in the Repository tree view 
and select Create file XML.
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5.8.1 Step 1: general properties

On the first step, fill in the schema generic information, such as Schema name and description. Click 
Next when you’re complete.

5.8.2 Step 2: file upload

Browse to the XML File to upload and fill in the Encoding if the system didn’t detect it 
automatically. 

The file preview shows the XML node tree structure. 

Click Next to the following step.

5.8.3 Step 3: schema definition

Set the parameters to be taken into account for the schema definition.
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The schema definition window is divided into four panels:

• Source Schema: Tree view of the uploaded XML file structure

• Target Schema: Extraction and iteration information

• Preview: Target schema preview 

• File viewer: Raw data viewer

In the Xpath loop expression field, enter the absolute xpath expression leading to the structure node 
which the iteration should apply on. You can type in the entire expression or press Ctrl+Space to 
get the auto completion list.
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Or else, drop the node from the source structure to the target schema Xpath field. 

 
The Xpath loop expression field is compulsory.

You can also define a Loop limit to restrict the iteration to a number of nodes. A green link is then 
created.

Then define the fields to extract. Simply drop the relevant node to the Relative or absolute XPath 
expression field.

Use the plus sign to add rows to the table and select as many fields to extract, as you need. Press the 
Ctrl or the Shift keys for multiple selection of grouped or separate nodes, and drag & drop them to 
the table.
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In the Tag name field, give a name the column header that will display on the schema preview 
(bottom left panel).

The selected link is blue, and all other links are grey. You can prioritize the order of fields to extract 
using the up and down arrows.

Click Refresh preview to display the schema preview. The fields will then be displayed in the 
schema preview in the order given (top field on the left).

5.8.4 Step 4: final schema

The schema generated shows the selected columns of the XML file. You can customize it upon your 
needs or reload the original schema using the Guess button. 

Click Finish. The new schema displays in the Repository tree view under the relevant File XML 
connection node. 

5.9 Setting up a File Excel schema

In the Repository tree view, right-click File Excel tree node, and select Create file Excel on the pop-up 
menu. 
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Then proceed the same way as for the file delimited connection.

5.9.1 Step 1: general properties

 Fill in the schema general information, such as Schema Name and Description.

5.9.2 Step 2: file upload

Browse to the file to upload and fill out the File field. 

 
You can upload all types of Excel files including ..xlsx of Excel 2007. 
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The File viewer and sheets setting area shows a preview of the file. 

In the Set sheets parameters list, select the dialog box next to the sheet you want to upload. By 
default the file preview displays the Sheet1.

Select another sheet on the drop-down list, if need be and check that the file is properly read on the 
preview table.

Click Next to continue.

5.9.3 Step 3: schema refining

The next step opens the schema setting window. 
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The same way as for the File Delimited schema procedure, you can set precisely the separator, the 
rows that should be skipped as they are header or footer.

You can fill out the First column and Last column fields, to set precisely the columns to be read 
in the file. You can need to skip column A for example as it may not contain proper data to be 
processed. 

Also check the Set heading row as column names to take into account the heading names. Make 
sure you press Refresh to be able to view the change in the preview table.

Then click Next to continue.

5.9.4 Step 4: final schema

Step 4 shows the final generated schema. Note that any character which could be misinterpreted by 
the program is replaced by neutral characters, like underscores replace asterisks. 

You can add a customized name (by default, metadata) and make edits to it using the tool bar. 

You can also retrieve or update the Excel File schema by clicking on Guess. Note however that any 
custom edits to the schema might thus be lost using this feature. 
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Click Finish. The new schema displays in the Repository tree view under the relevant File Excel 
connection node. 

5.10 Setting up a File LDIF schema  

LDIF files are directory files described by attributes. File LDIF metadata centralize these LDIF-type 
files and their attribute description.

Proceed the same way as for other file connections. Right-click Metadata in the Repository tree view 
and select Create file Ldif.

Make sure that you installed the relevant Perl module as described in the Installation guide. For more 
information, check out http://talendforge.org/wiki/doku.php.

5.10.1 Step 1: general properties

On the first step, fill in the schema generic information, such as Schema name and description.

5.10.2 Step 2: file upload

Then define the Ldif file connection settings by filling in the File path field.
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The connection functionality to a remote server is not operational yet for the LDIF file 
collection.

The File viewer provides a preview of the file’s first 50 rows. 

5.10.3 Step 3: schema definition

The list of attributes of the description file displays on the top of the panel. Select the attributes you 
want to extract from the LDIF description file, by selecting the relevant check boxes.
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Click Refresh Preview to include the selected attributes into the file preview. 

DN is omitted in the list of attributes as this key attribute is automatically included in 
the file preview, hence in the generated schema.

5.10.4 Step 4: final schema 

The schema generated shows the columns of the description file. You can customize it upon your 
needs and reload the original schema using the Guess button. 

Click Finish. The new schema displays in the Repository tree view under the relevant Ldif file 
connection node. 

5.11 Setting up an LDAP schema

In the Repository tree view, right-click the LDAP tree node, and select Create LDAP schema on the 
pop-up menu.
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Unlike the DB connection wizard, the LDAP wizard gathers both file connection and schema definition 
in a four-step procedure.

5.11.1 Step 1: general properties

On the first step, fill in the schema generic information, such as Schema Name and Description.

For further information, see Step 1: general properties on page 142.

5.11.2 Step 2: server connection

Fill the connection details.

Then check your connection using Check Network Parameter to verify the connection and 
activate the Next button. 

Click Next to validate this step and continue.

5.11.3 Step 3: authentication and DN fetching

In this view, set the authentication and data access mode. 

Field Description

Host LDAP Server IP address

Port Listening port to the LDAP directory

Encryption method LDAP : no encryption is used 
LDAPS: secured LDAP 
TLS: certificate is used 
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Click Check authentication to verify your access rights.

Field Description

Authentication method Simple authentication: requires Authentication Parameters 
field to be filled in  
Anonymous authentication: does not require authentication 
parameters

Authentication Parameters Bind DN or User: login as expected by the LDAP authentication 
method 
Bind password: expected password 
Save password: remembers the login details.

Get Base DN from Root DSE / 
Base DN

Path to user’s authorized tree leaf 
Fetch Base DNs button retrieves the DN automatically from Root.
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Click Fetch Base DNs to retrieve the DN and click the Next button to continue.

5.11.4 Step 4: schema definition

Select the attributes to be included in the schema structure. 

Add a filter if you want selected data only.

Alias Dereferencing Never allows to improve search performance if you are sure 
that no aliases is to be dereferenced. By default, Always is to be 
used. 
Always: Always dereference aliases 
Never: Never dereferences aliases. 
Searching:Dereferences aliases only after name resolution. 
Finding: Dereferences aliases only during name resolution

Referral Handling Redirection of user request: 
Ignore: does not handle request redirections  
Follow:does handle request redirections

Limit Limited number of records to be read

Field Description
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Click Refresh Preview to display the selected column and a sample of the data. 

Then click Next to continue.

5.11.5 Step 5: final schema

The last step shows the LDAP schema generated. You can customize the schema using the toolbar 
underneath the table.
172 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/


Managing Metadata
Setting up a Salesforce schema
If the LDAP directory which the schema is based on has changed, use the Guess button to generate 
again the schema. Note that if you customized the schema, your changes won’t be retained after the 
Guess operation.

Click Finish. The new schema displays in the Repository tree view under the relevant LDAP 
connection node.

5.12 Setting up a Salesforce schema

In the Repository tree view, right-click the Salesforce tree node, and select Create Salesforce on the 
pop-up menu. 

Then proceed the same way as for any other metadata connection.
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5.12.1 Step 1: general properties

 Fill in the schema general information, such as Schema Name and Description.

5.12.2 Step 2: connection to a Salesforce account

The Salesforce a Web service URL displays by default in the Web service URL field.

• Enter your user name and password in the corresponding fields to connect to your Salesforce 
account through the salesforce webservice.

• From the Standard objects list, select the object you want to access and get the schema 
from.

• In the Standard objects list, select the standard or personalized object you want to access 
and get the schema from.

• Click Check Login to verify that you can connect without issue.

• Click Next to continue.

5.12.3 Step 3: schema refining

The next step opens the schema setting window based on the Module you selected in Step 2. 
174 Talend Open Studio Creative Commons License

http://creativecommons.org/licenses/by-nc-sa/2.0/


Managing Metadata
Setting up a Salesforce schema
You can narrow down the selection using the Query field. Simply type in the column you want to 
filter on and the value you want to drill down to.

In the Browse data column and set query condition area, you can narrow down the selection and 
filter displayed data. To do that, type in the column you want to filter on and the value you want to 
drill down to in the Query Condition field.

The columns in the Column list are listed in alphabetical order. Select the order the fields check 
box to list them randomly. 

Click Refresh Preview, if you entered a query condition, so that the preview gets updated 
accordingly. By default, the preview shows all columns of the selected module.

Then click Next to continue.

5.12.4 Step 4: final schema

Step 4 shows the final generated schema.

You can add a customized name (by default, metadata) and make edits to the schema using the tool 
bar. 
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You can also retrieve or update the Salesforce schema by clicking on Guess. Note however that any 
custom edits to the schema might thus be lost using this feature. 

Click Finish. The new schema displays in the Repository tree view under the relevant File Excel 
connection node. 

5.13 Setting up a Generic schema

Talend Open Studio allows you to create any schema from scratch if none of the specific metadata 
wizards matches your need or if you don’t have any source file to take the schema from. The creation 
procedure is made of two steps.

First right-click Generic Schema in the Repository tree view and select Create generic schema.

5.13.1 Step 1: general properties

A connection wizard opens up. Fill in the generic Schema properties such as Schema Name and 
Description. The Status field is a customized field you can define in Window > Preferences. 

Click Next when completed. 
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5.13.2 Step 2: schema definition

There is no default schema displaying as there is no source to take it from.

• You can give a name to the schema or use the default name (metadata) and add a comment 
if you feel like. 

• Then, customize the schema structure in the schema panel, based on your needs. 

• Indeed, the tool bar allows you add, remove or move columns in your schema. Also, you can 
load an xml schema or export the current schema as xml. 

• Click Finish to complete the generic schema creation. All created schemas display under the 
relevant Generic Schemas connection node. 

5.14 Setting up a WSDL schema

Talend Open Studio allows you to store your WSDL connections in the Repository tree view. The 
creation procedure is made of three steps.

First right-click WSDL in the Repository tree view and select Create WSDL schema.

5.14.1 Step 1: general properties

A connection wizard opens up. Fill in the generic Schema properties such as Schema Name and 
Description. The Status field is a customized field you can define in Window > Preferences. 

Click Next when completed. 

5.14.2 Step 2: URI and method definition

On the Step 2, define the URI and parameters required to return values. 

• Fill in the WSDL URI that will return the requested values.
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• Fill in the authentication details if relevant or the Proxy information if needed.

• Define the method that should be called in the Method field. 

• Click Add to add the parameters required by the method. 

• Then click Preview to check that the setting is correct.

The preview displays the values that should be returned by the webservice method based on the 
given parameters.

5.14.3 Step 3: final schema

You can add a customized name (by default, metadata) and make edits to schema using the tool bar. 
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You can also retrieve or update the original schema by clicking on Guess. Note however that any 
edits to the schema might be lost after guessing the schema.

Click Finish. The new schema displays in the Repository tree view under the relevant WSDL 
connection node.

5.15 Exporting a Metadata as context

For every Metadata connection (either File or Database), you can export the connection details as a 
Context. 

• On the last step or second last step of the wizard, click Export as Context.

• The Context creation 2-step wizard launches.

• On Step 1, fill out a name for the Context. By default the name of the Metadata entry is proposed.

• Click Next.

• On Step 2, the automatically created context variables are displaying on the three tab table. 
Check out that the variable values showing on the Values tab are correctly set.

• Click Finish to validate the creation.
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CHAPTER 6 

Managing jobs 
This chapter describes the management procedures you can carry on the Jobs you design in Talend 
Open Studio or you can carry on any of the items included in a project, for example routines or 
metadata. These management procedures include importing and exporting Jobs and items between 
different projects or machines and also scheduling job execution and running and deploying jobs on 
distant servers.



Managing jobs
Importing items
6.1 Importing items

You can import items from previous versions of Talend Open Studio or from a different project of 
your current version.

The items you can possibly import are multiple:

• Business Models

• Jobs Designs

• Routines

• Documentation

• Metadata

Follow the steps below to import them to the repository: 

• In the Repository tree view, right-click any entry such as Job Designs or Business Models.

• On the pop-up menu, select the Import Items option.

• A dialog box prompts you to select the root directory or the archive file to extract the items from.

• If you exported the items from your local repository into an archive file (including source files 
and scripts), select the archive filepath, browse to the file then click OK.

• If the items to import are still stored on your local repository, select Root Directory and browse 
to the relevant project directory on your system.

• Browse down to the relevant Project folder within the workspace directory. It should correspond 
to the project name you picked up.
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• If you only want to import very specific items such as some Job Designs, you can select the 
specific folder, such as Process where all the job designs for the project are stored. If you only 
have Business Models to import, select the specific folder: BusinessProcess.

• But if your project gather various types of items (Business Models, Jobs Designs, Metadata, 
Routines...), we recommend you to select the Project folder to import all items in one go. 

• Then click OK to continue.
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• In the Items List are displayed all valid items that can be imported. All items are selected by 
default, but you can individually clear the check boxes of unwanted items.

• Click Finish to validate the import. 

• The imported items display on the repository in the relevant folder respective to their nature. 

6.2 Exporting job scripts

The export job script feature allows you to deploy and execute a job on any server, regardless of Talend 
Open Studio. 

Exporting job script adds to an archive all the files required to execute the job, including the .bat and .sh 
along with the possible context-parameter files or relative files.

The [Export Job Scripts] dialog boxes differ whether you work on a Java or a Perl version of the 
product.
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6.2.1 How to export Jobs in Java

To export job scripts:

• In the DQ Repository tree view, right-click the Job(s) you want to export the script of.

• Select Export Job Scripts to open the [Export Job Scripts] dialog box.

You can show/hide a tree view of all created Jobs in Talend Open Studio directly 

from the [Export Job Scripts] dialog box by clicking the  and the  buttons 
respectively. The Jobs you earlier selected in the Studio tree view display with selected check 
boxes. This accessibility helps to modify the selected items to be exported directly from the 
dialog box without having to close it and go back to the DQ Repository tree view in Talend 
Open Studio to do that.

• On the To archive file field, browse to the type of files you want to add to your archive.

• On the Job Version area, select the version number of the Job you want to export if you have 
created more than one version of the Job.

• Select the Export Type in the list including Autonomous Job, Axis Webservice (WAR), 
Axis Webservice (Zip), and JBOSS ESB.

• In the Options zone, select the file type(s) you want to add to the archive file. The check 
boxes corresponding to the file types necessary for the execution of the Job are selected by 
default. You can clear these check boxes depending on what you want to export.

• To export the .bat and .sh files necessary to launch the exported Job, select Shell launcher 
check box.
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• To export the user or system routines used in the specified Job, select the System routines 
and User routines check boxes.

• To export Talend modules, select the Required Talend modules check box.

• To export the .jar file holding Java classes necessary for job execution in Java, select the Job 
scripts check box.

• To export the sources used by the Job during its execution including the files .item, 
.properties and java sources of Jobs and routines, select the Source files check box.

If you select the Source files check box, you can reuse the exported Job in a 
Talend Open Studio installed on another machine. These source files are 
only used in Talend Open Studio.

• Select the Export Dependencies check box if you want to export the dependencies with 
your Job, i.e. contexts, routines, connections, etc.

• Select the Context script check box to export all context parameters files and not just those 
you select in the list.

• From the Context script list, select the context that fits your needs, including the .bat or .sh 
files holding the appropriate context parameters. Then you can, if you wish, edit the .bat and 
.sh files to manually modify the context type.

• Select the Apply to children check box if you want to apply the selected context from the 
list to all children jobs.

• Click Finish to validate your changes, complete the export operation and close the dialog 
box.

A zipped file for job scripts is created in the defined place.

Exporting jobs as Autonomous Job

In the case of a Plain Old Java Object export, if you want to reuse the Job in Talend Open 
Studio installed on another machine, make sure you selected the Source files check box. These 
source files (.item and .properties) are only needed within Talend Open Studio.

Select a context in the list when offered. The .bat/.sh file will thus include this context setting 
as default for the execution. But note that all contexts parameter files are exported along in 
addition to the one selected in the list. You will thus be able to edit the .bat/.sh file to change 
manually the context selection if you want to.

If you want to change the context selection, simply edit the .bat/.sh file and change the following 
setting: --context=Prod to the relevant context.

If you want to change the context settings, then edit the relevant context .properties file.

Exporting Jobs as Webservice

In the [Export Job Scripts] dialog box, you can change the type of export in order to export 
the job selection as Webservice archive.
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Select the type of archive you want to use in your Web application.

Once the archive is produced, place the WAR or the relevant Class from the ZIP (or unzipped 
files) into the relevant location, of your Web application server.

The URL to be used to deploy the job, typically reads as follow:   
http://localhost:8080/Webappname/services/JobName?method=runJo
b&args=null 

where the parameters stand as follow:

The call return from the Web application is 0 when there is no error and different from 0 in case 
of error. For a real-life example of creating and exporting a Job as a Websrvice and calling the 
exported Job from a browser, see An example of exporting a Job as a Web service on page 187.

The tBufferOutput component was especially designed for this type of deployment. For more 
information regarding this component, see tBufferOutput of the Talend Open Studio 
Components Reference Guide.

An example of exporting a Job as a Web service

This scenario describes first a simple Job that creates a .txt file and writes in it the current date 
along with first and last names. Second, it shows how to export this Job as a Webservice. And 
finally, it calls the Job exported as a Webservice from a browser. The exported Job as a 
Webservice will simply return the “return code” given by the operating system.

Creating the Job:

• Drop the following components from the Palette onto the design workspace: 
tFixedFlowInput and tFileOutputDelimited.

Archive type Description

WAR The options are read-only. Indeed, the WAR archive generated 
includes all configuration files necessary for the execution or 
deployment from the Web application.

ZIP All options are available. In the case the files of your Web 
application config are all set, you have the possibility to only 
set the Context parameters if relevant and export only the 
Classes into the archive.

URL parameters Description

http://localhost:8080/ Type in the Webapp host and port 

/Webappname/ Type in the actual name of your web application

/services/ Type in “services” as the standard call term for web services

/JobName Type in the exact name of the Job you want to execute

?method=runJob&args=null The method is RunJob to execute the Job.
Creative Commons License Talend Open Studio 187

http://creativecommons.org/licenses/by-nc-sa/2.0/


Managing jobs
Exporting job scripts
• Connect tFixedFlowInput to tFileOutPutDelimited using a Row Main link.

• In the design workspace, select tFixedFlowInput.

• Click the Component tab to define the basic settings for tFixedFlowInput.

•  Set the Schema Type to Built-In and click the three-dot [...] button next to Edit 
Schema to describe the data structure you want to create from internal variables.In this 
scenario, the schema is made of three columns, now, firstname, and lastname.

• Click the plus button to add the three parameter lines and define your variables.

• Click OK to close the dialog box and accept propagating the changes when prompted by 
the system. The three defined columns display in the Values panel of the Basic settings 
view of tFixedFlowInput.

• Click in the Value cell of each of the three defined columns and press Ctrl+Space to 
access the global variable list.

• From the global variable list, select TalendDate.getCurrentDate(), 
talendDatagenerator.getFirstName, and talendDataGenerator.getLastName for the 
now, firstname, and lastname columns respectively.

• In the Number of rows field, enter the number of lines to be generated.
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• In the design workspace, select tFileOutputDelimited.

• Click the Component tab for tFileOutputDelimited and browse to the output file to set 
its path in the File name field. Define other properties as needed.

If you press F6 to execute the Job, three rows holding the current date and first and last names 
will be written to the set output file.

Exporting the Job as a Webservice:

• In the Repository tree view, right-click the above created Job and select Export Job 
Scripts. The [Export Job Scripts] dialog box displays.
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• Click the Browse... button to select a directory to archive your Job in.

• In the Job Version area, select the version of the Job you want to export as a web service.

• In the Export type area, select the export type you want to use in your Web application 
(WAR in this example) and click Finish. The [Export Job Scripts] dialog box 
disappears.

• Copy the War folder and paste it in the Tomcat webapp directory.

Calling the Job from a browser:

Type the following URL into your browser: 
http://localhost:8080//export_job/services/export_job2?method=runJob where “export_job” 
is the name of the webapp directory deployed in Tomcat and “export_job2” is the name of the 
Job.

Click Enter to execute the Job from your browser.
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The return code from the Web application is 0 when there is no error and 1 if an error occurs. 

For a real-life example of creating and exporting a Job as a Webservices using the 
tBufferOutput component, see Scenario 2: Buffering output data on the webapp server of 
Talend Open Studio Components Reference Guide.

Exporting Jobs as JBoss ESB

In order to be able to deploy and execute a Job on a JBoss ESB server, make sure that the jar specific to 
JBoss ESB is installed in the Java library and that it displays in the Modules view of Talend Open 
Studio. For more information about the Modules view, see Modules view on page 30.

In the [Export Job Scripts] dialog box, you can change the type of export in order to export 
the selected Job as an ESB archive. You can then deploy this exported Job on a JBoss server.

To export a Job on ESB:

• From the Select export type list in the Export type area, select JBoss ESB.

• In the Option area, select the file type you want to add to the archive. When the Context 
script list displays more than one context, select the one you need.

• Select the Export Dependencies check box if you want to export dependencies with 
your Job, i.e. contexts, routines, connections, etc.

• In the Message Queue Name, enter the name of the queue that is used to deploy the Job.

• Click the Browse... button next to the To archive file field and select the deployment 
directory of the JBoss server, for example: 
jbossesb-server-4.5.GA\server\default\deploy for a JBoss ESB 
server, version 4.5.

When you launch the server, or when you copy the ESB archive in the deployment directory, 
the Job is automatically deployed and will be ready to be executed on the ESB server.
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6.2.2 How to export jobs in Perl

To export job scripts:

• Right-click the relevant job in the Repository tree view.

• Select Export Job Scripts to open the [Export Job Scripts] dialog box.

You can show/hide a tree view of all created Jobs in Talend Open Studio directly 

from the [Export Job Scripts] dialog box by clicking the  and the  buttons 
respectively. The Jobs you earlier selected in the Studio tree view display with selected check 
boxes. This accessibility helps to modify the selected items to be exported directly from the 
dialog box without having to close it and go back to the DQ Repository tree view in Talend 
Open Studio to do that.

• In the To archive file field, browse to the type of files you want to add to your archive.

• From Select the job version list, select the version number of the Job you want to export.

• Select Extract the zip file check box to export the archive file and its version extracted from 
your Job.

• In the Options zone, select the file type(s) you want to add to the archive file. The check 
boxes corresponding to the file types necessary for the execution of the Job are selected by 
default. You can clear these check boxes depending on what you want to export.
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• To export the .bat and .sh files necessary to launch the exported Job, select Shell launcher 
check box.

• To export the user or system routines used in the specified Job, select the System routines 
and User routines check boxes.

• To export Talend modules, select the Required Talend modules check box.

• To export the .jar file holding Java classes necessary for job execution in Java, select the Job 
scripts check box.

• To export the sources used by the Job during its execution including the files .item, 
.properties and java sources of Jobs and routines, select the Source files check box.

If you select the Source files check box, you can reuse the exported Job in a 
Talend Open Studio installed on another machine. These source files are 
only used in Talend Open Studio.

• Select the Export Dependencies check box if you want to export the dependencies with 
your Job, i.e. contexts, routines, connections, etc.

• Select the Context script check box to export all context parameters files and not just those 
you select in the list.

• From the Context script list, select the context that fits your needs, including the .bat or .sh 
files holding the appropriate context parameters. Then you can, if you wish, edit the .bat and 
.sh files to manually modify the context type.

• Select the Apply to children check box if you want to apply the selected context from the 
list to all children jobs.

If you want to change the context selection, simply edit the .bat/.sh file and 
change the following setting: --context=Prod to the relevant context. 
If you want to change the context settings, then edit the relevant context properties file.

• Click Finish to validate your changes, complete the export operation and close the dialog 
box.

A zipped file for job scripts is created in the defined place.

 You cannot import job script into a different version of Talend Open Studio than the one the jobs were 
created in. To be able to reuse previous jobs in a later version of Talend Open Studio, use the Import 
Project function. See How to import a project on page 14.

6.2.3 How to chang context parameters in job scripts

As explained in sections How to export Jobs in Java on page 185 and How to export jobs in Perl 
on page 192, you can edit the context parameters:

If you want to change the context selection, simply edit the .bat/.sh file and change the following 
setting: --context=Prod to the relevant context.

If you want to change individual parameters in the context selection, edit the .bat/.sh file and add 
the following setting according to your need:  
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6.3 Exporting items

You can export multiple items from the repository onto a directory or an archive file. Hence you have 
the possibility to export metadata information such as DB connection or Documentation along with your 
job Script or your Business Model, for example.

• In the Repository tree view, select the items you want to export.

• For multiple select, press the Ctrl key and select the relevant items.

If you want to export a database table metadata entry, make sure you select the whole DB connection, and 
not only the relevant table as this will prevent the export process to complete correctly.

• Right-click while maintaining the Ctrl key down and select Export items on the pop-up menu.

• Then select the directory where you want to store the exported items. Alternatively, define the 
archive file where to compress the files for all selected items.

• Click Finish. 

Operations Setting

to change value1 for parameter key1 --context_param key1=value1 

to change value1 and value2 for 
respective parameters key1 and key2

--context_param key1=value1 
--context_param key2=value2 

to change a value containing space 
characters such as in a file path

--context_param key1=”path to file”
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6.4 Deploying a Job on SpagoBI server

From Talend Open Studio interface, you can deploy your jobs easily on a SpagoBI server in order to 
execute them from your SpagoBI administrator.

6.4.1 How to create a SpagoBI server entry

Beforehand, you need to set up your single or multiple SpagoBI server details in Talend Open 
Studio.

• On the menu bar, click Window > Preferences to open the [Preferences] dialog box.

• Expand the Talend > Import/Export nodes in succession and select SpagoBI Server to 
display the relevant view.

• Select the Enable/Disable Deploy on SpagoBI check box to activate the deployment 
operation.

• Click New to open the [Create new SpagoBi server] dialog box and add a new server to the 
list.
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• In the Engine Name field, enter the internal name used in Talend Open Studio. This name 
is not used in the generated code.

• In the Short description field, enter a free text to describe the server entry you are recording.

• Fill in the host and port information corresponding to your server in the corresponding fields. 
Host can be the IP address or the DNS Name of your server.

• Type in the Login and Password as required to log on the SpagoBI server.

• In Application Context, type in the context name as you created it in Talend Open Studio

• Click OK to validate the details of the new server entry and close the dialog box.

The newly created entry is added to the table of available servers. You can add as many SpagoBI 
entries as you need.

• Click Apply and then OK to close the [Preferences] dialog box.

6.4.2 How to edit or remove a SpagoBI server entry

Select the relevant entry in the table, click the Remove button next to the table to first delete the 
outdated entry. 

Then if required, simply create a new entry including the updated details.

6.4.3 How to deploy your jobs on a SpagoBI server

Follow the steps below to deploy your Job(s) onto a SpagoBI server.
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• In the Repository tree view, expand Job Designs and right-click the Job to deploy.

• In the drop-down list, select Deploy on SpagoBI.

• As for any job script export, select a Name for the job archive that will be created and fill it 
in the To archive file field.

• Select the relevant SpagoBI server on the drop-down list.

• The Label, Name and Description fields come from the job main properties.

• Select the relevant context in the list.

• Click OK once you’ve completed the setting operation.

The jobs are now deployed onto the relevant SpagoBI server. Open your SpagoBI administrator to 
execute your jobs.
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APPENDIX A 

Theory into practice: Job example
This chapter aims at users of Talend Open Studio who seek a real-life use case to help them take 
full control over the product. This chapter comes as a complement of the Talend Open Studio 
Components Reference Guide.



Introducing the scenario
A.1 Introducing the scenario

To illustrate the way Talend Open Studio operates, find below a real-life example scenario. In this 
scenario, we will load a MySQL table with a file, that gets transformed on the fly. Then in a further step, 
we will select the data to be loaded using a dynamic filter.

Before actually starting the Job, let’s inspect the input data and the expected output data.

This scenario is provided in Java, but the same Job can be carried out in a Perl project, with 
significant differences in the way transformations are phrased.

A.1.1 Input data

Our input file, the data of which will be loaded into the database table, lists clients from all over the 
State of California.

The file structure usually called Schema in Talend Open Studio includes the following columns:

• First name

• Last name

• Address

• City

A.1.2 Output data

We want to load into the database, California clients living in a couple of Counties only: Orange and 
Los Angeles counties.

The table structure is slightly different, therefore the data expected to be loaded into the DB table 
should have the following structure:

• Key (key, Type: Integer)

• Name (Type: String, max. length: 40)

• Address (Type: String, max.length: 40)

• County (Type: String, max. length:40)

In order to load this table, we will need to use the following mapping process:

The Key column is fed with an auto-incremented integer.

The Name column is filled out with a concatenation of first and last names.

The Address column data comes from the equivalent Address column of the input file, but 
supports a upper-case transformation before the loading.

The County column is fed with the name of the County where the city is located using a reference 
file which will help filtering Orange and Los Angeles counties’ cities. 
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A.1.3 Reference data

As only Orange and Los Angeles counties data should be loaded into the database, we need to map 
cities of California with their respective county, in order to filter only Orange and Los Angeles ones.

To do so, we will use a reference file, listing cities that are located in Orange and Los Angeles 
counties such as:

The reference file in this Job is named LosAngelesandOrangeCounties.txt. 

A.2 Translating the scenario into a Job

In order to implement this scenario, let’s split this Job into four stages.

• Stage 1: Creation of the Job, configuration of the input file parameters, and reading of the input 
file,

• Stage 2: Mapping of data and transformations,

• Stage 3: Definition of the reference file parameters, relevant mapping using the tMap 
component, and selection of inner join mode,

• Stage 4: Redirection of the output into a MySQL table.

A.2.1 Stage 1: Job creation, input definition, file reading

After launching Talend Open Studio, you need to create a connection to the local repository. To do 
so, click “...” to the right of Connection.

In the User Email field, type in your email (!) then click OK.

Then click the Demo button and select Java to import the DEMO JAVA project jobs. This operation 
will need a while to complete but will give you access to dozen of job examples, illustrating the main 
functionalities of Talend Open Studio.

Then click OK to launch the Studio. And click the link Start using Talend Open Studio now! to 
access directly the main window.

The window is divided into several areas:

• To the left: the Repository tree view that holds Jobs, Business Models, Metadata, shared 
Code, Documentation and so on. 

• In the center: the Editor (main Design area)

• At the bottom: Component and Job tabs

City County

Agoura Hills Los Angeles

Alhambra Los Angeles

Aliso Viejo Orange

Anaheim Orange

Arcadia Los Angeles
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• To the right: the Palette of business or technical components depending on the software tool 
you are using within Talend Open Studio.

To the left of the Studio, the Repository tree view that gives an access to:

• The Business Modeler: For more information, see Modeling a Business Model on page 55.

• The Job Designer: For details about this part, see Getting started with a Job Design on 
page 68.

• The Metadata Manager: For details about this part, see Defining Metadata items on 
page 92.

To create the Job, right-click Job Designs in the Repository tree view and select Create Job.

In the dialog box displaying then, only the first field (Name) is required. Type in California1 and 
click Finish.

An empty Job then opens on the main window and the Palette of technical components (by default, 
to the right of the Studio) comes up showing a dozen of component families such as: Databases, 
Files, Internet, Data Quality and so on, hundreds of components are already available.

To read the file California_Clients, let’s use the tFileInputDelimited component.This component 
can be found in the File/Input group of the Palette. Click this component then click to the left of 
the design workspace to place it on the design area.

Let’s define now the reading properties for this component: File path, column delimiter, encoding... 
To do so, let’s use the Metadata Manager. This tool offers numerous wizards that will help us to 
configure parameters and allow us to store these properties for a one-click re-use in all future Jobs 
we may need.

As our input file is a delimited flat file, let’s select File Delimited on the right-click list of the 
Metadata folder in the Repository tree view. Then select Create file delimited. A wizard dedicated 
to delimited file thus displays:

• At Step1, only the Name field is required: simply type in California_clients and go to the 
next Step.

• At Step2, select the input file (California_Clients.csv) via the Browse... button. Immediately 
an extract of the file shows on the Preview, at the bottom of the screen so that you can check 
its content. Click Next.

• At Step3, we will define the file parameters: file encoding, line and column delimiters... As 
our input file is pretty standard, most default values are fine. The first line of our file is a 
header containing column names. To retrieve automatically these names, click Set heading 
row as column names then click Refresh Preview. And click Next to the last step.

•  At Step4, each column of the file is to be set. The wizard includes algorithms which guess 
types and length of the column based on the file first data rows. The suggested data 
description (called schema in Talend Open Studio) can be modified at any time. In this 
particular scenario, they can be used as is.

There you go, the California_clients metadata is complete!

We can now use it in our input component. Select the tFileInputDelimited you had dropped on the 
design workspace earlier, and select the Component Settings tab at the bottom of the window.
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Select the vertical tab Basic Settings. In this tab, you’ll find all technical properties required to let 
the component work. Rather than setting each one of these properties, let’s use the Metadata entry 
we just defined.

Select Repository as Property type in the list. A new field shows: Repository, click “...” button 
and select the relevant Metadata entry on the list: California_clients. You can notice now that all 
parameters get automatically filled out.

At this stage, we will terminate our flow by simply sending the data read from this input file onto 
the standard output (StdOut).

To do so, add a tLogRow component (from the Logs & Errors group). 

To link both components, right-click the input component and select Row/Main. Then click the 
output component: tLogRow.

This Job is now ready to be executed. To run it, select the Run tab on the bottom panel.

Enable the statistics by selecting the Statistics check box then run the Job by clicking Run. 
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The content of the input file display thus onto the console.

A.2.2 Stage 2: Mapping and transformations

We will now enrich our Job to include on-the-fly transformations. To implement these 
transformation, we need to add a tMap component to our Job. This component is multiple and can 
handle:

• multiple inputs and outputs

• search for reference (simple, cartesian product, first, last match...)

• join (inner, outer)

• transformations

• rejections 

• and more...

Remove the link that binds together the job’s two components via a right-click the link, then Delete 
option.Then place the tMap inbetween before linking the input component to the tMap as we did 
it previously.

Eventually to link the tMap to the standard output, right-click the tMap component and select 
Row/*New Output* (Main).Type in out1 in the dialog box and click the tLogRow component to 
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implement the link. Logically, a message box shows up (for the back-propagation of schemas), 
ignore it by clicking on No.

Now, double-click the tMap to access its interface.

To the left, you can see the schema (description) of your input file (row1). To the right, your output 
is for the time being still empty (out1).

Drop the FirstName and LastName columns to the right, onto the Name column as shown on the 
screen below. Then drop the other columns Address and City to their respective line.

Then carry out the following transformations on each column:

• Change the Expression of the Name column to row1.Firstname + " " +  
row1.LastName. Concatenate the Firstname column with the Lastname column 
following strictly this syntax (in Java), in order for the columns to display together in one 
column.

• Change the Expression of the Address column to row1.Address.toUpperCase() 
which will thus change the address case to upper case. 

These transformations are stated in Java for this Job and would require a different 
syntax if you use them in a Perl project.

Then remove the LastName column from the out1 table. To do so, go to the Schema Editor located 
at the bottom of the Map editor. Select the column to be removed from the schema, and click the 
cross icon.

No transformation is made onto the City column. Click OK to validate the changes and close the 
Map editor interface.

If you run your Job at this stage (via the Run tab as we did it before), you’ll notice the changes that 
you defined are implemented.
Creative Commons License Talend Open Studio 205

http://creativecommons.org/licenses/by-nc-sa/2.0/


Translating the scenario into a Job
For example, the Address case has been to upper case and the first names and last names are gathered 
together in the same column.

A.2.3 Stage 3: Reference file definition, re-mapping, inner join 
mode selection

Define the Metadata corresponding to the LosAngelesandOrangeCounties.txt file just the way we 
did it previously for California_clients file, using the wizard.

At Step1 of the wizard, name this metadata entry: LA_Orange_cities.

Then drop this newly created metadata to the top of the design area to create automatically a reading 
component pointing to this metadata.

Then link this component to the tMap component.
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Double-click again on the tMap component to open its interface. Note that the reference input table 
(row2) corresponding to the LA and Orange county file, shows to the left of the window, right under 
your main input (row1).

Now let’s define the join between the main flow and the reference flow. In this use case, the join is 
pretty basic to define as the City column is present in both files and the data match perfectly. But 
even though this was not the case, we could have carried out operations directly at this level to 
establish a link among the data (padding, case change...)

To implement the join, drop the City column from your first input table onto the City column of your 
reference table. A violet link then displays, to materialize this join.

Now, we are able to use the County column from the reference table in the output table (out1).
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Eventually, click the OK button to validate your changes, and run the new Job.

The following output should display on the console.

As you can notice, the last column is only filled out for Los Angeles and Orange counties’ cities. 
For all other lines, this column is empty. The reason for this is that by default, the tMap implements 
an inner join mode. If you want to filter your data to only display lines for which a match is found 
by the tMap, then open again the tMap and select the Inner Join check box on the reference table 
(row2).

A.2.4 Stage 4: Output to a MySQL table

Our Job works perfectly! To finalize it, let’s direct the output flow to a MySQL table.

To do so, let’s first create the Metadata describing the connection to the MySQL database. 
Double-click Metadata/MySQL/DemoMySQL in the referential (on the condition that you imported 
the Demo project properly). This opens the Metadata wizard.

On Step2 of the wizard, type in the relevant connection parameters. Check the validity of this 
connection by clicking on the Check button. Eventually, validate your changes, by clicking on 
Finish.

Drop this metadata to the right of the design workspace, while maintaining the Ctrl key down, in 
order to create automatically a tMysqlOutput component.
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Remove the tLogRow component from your Job.

Reconnect the out1 output flow from the tMap to the new component tMysqlOutput 
(Right-click/Row/out1):

On the Basic Settings tab of this component:

• Type in LA_Orange_Clients in the Table field, in order to name your target table which will 
get created on the fly.

• Select the Drop table if exists and create option or on the Action on table field.

• Click Edit Schema and click the Reset DB type button (DB button on the tool bar) in order 
to fill out automatically the DB type if need be.

Run again the Job. The target table should be automatically created and filled with data in less a a 
second!

In this scenario, we did use only four different components out of hundreds of components available 
in the Palette and grouped according to different categories (databases, Webservice, Ftp and so on)!

And more components, this time created by the community, are also available on the community site 
(talendforge.org).

For more information regarding the components, check out Talend Open Studio Components 
Reference Guide.
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